Guest Operating System
Installation Guide

March 10, 2011

Note:

The contents of the Guest Operating System Installation Guide have changed. The new version of this
guide contains information and instructions applicable only to installing guest operating systems.
For guest operating system support data, see the new Guest/Host OS VMware Compatibility Guide.
For VMware Tools information, see the applicable product documentation on the VMware
Documentation Web site http://www.vmware.com/support/pubs/.

For known issues, see the VMware Knowledge Base located at http://kb.vmware.com/.

The deprecated Guest Operating System Installation Guide, the new version of the Guest Operating
System Installation Guide, and the new Guest/Host OS VMware Compatibility Guide are all located at
http://www.vmware.com/resources/compatibility/search.php?deviceCategory=software.

GSTOS-ENG-Q110-200-1

vmware


http://www.vmware.com/support/pubs/
http://kb.vmware.com/
http://kb.vmware.com
http://www.vmware.com/resources/compatibility/search.php?deviceCategory=software

Guest Operating System Installation Guide

You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/

The VMware Web site also provides the latest product updates.

If you have comments about this documentation, submit your feedback to:

docfeedback@vmware.com

© Copyright 2006-2011 VMware, Inc. All rights reserved. This product is protected by U.S. and international copyright and
intellectual property laws. VMware products are covered by one or more patents listed at
http://www.vmware.com/go/patents.

VMware is a registered trademark or trademark of VMware, Inc. in the United States and/or other jurisdictions. All other marks
and names mentioned herein may be trademarks of their respective companies.

VMware, Inc.

3401 Hillview Ave.
Palo Alto, CA 94304
www.vmware.com

2 VMware, Inc.


http://www.vmware.com/go/patents
http://www.vmware.com/support/
http://www.vmware.com/support
mailto:docfeedback@vmware.com

Contents

About This Book 7

Installing Guest Operating Systems 11
Latest Updates 11
Operating Systems That the Operating System Vendor No Longer Supports 12
General Guidelines for Supported Guests 13
Determining Memory Settings for a Virtual Machine 13
Using Sound Adapters on GSX and VMware Servers 13
Running a Guest Operating System 13
64-Bit Linux Guests and Execute Disable Functionality 13
VMware Tools 13
General Installation Instructions for All VMware Products 13
Typical Installation 14
ISO Installation 14
PXE Installation 14
Windows 7 14
Windows Preinstallation Environment 15
VMware Tools Support in Windows Preinstallation Environment 15
Windows Recovery Environment 16
VMware Tools in Windows Recovery Environment 16
Windows Server 2008 R2 16
Windows Server 2008 16
Windows Vista 17
Missing Multimedia Audio Controller in a Windows Vista Guest 17
Screen Resolution in a Windows Vista Guest 17
Windows Server 2003 17
Missing Multimedia Audio Controller in a Windows Server 2003 Guest 18
Windows XP 18
Windows 2000 19
VMware Tools in a Windows 2000 Guest 19
Windows NT 4.0 20
Enable DMA Transfer Support 20
Enabling Networking After Installing Windows NT 4.0 21
VMware Tools in a Windows NT 4.0 Guest 21
Windows Me 21
Windows 98 22
Enabling Networking After Installing Windows 98 22
Windows 95 23
Enable DMA Transfers 24
Enable Networking After Windows 95 Installation in a Virtual Machine 24
Troubleshooting Windows 95 Installations in a Virtual Machine 25
MS-DOS 6.22 and Windows 3.1x 25
Install MS-DOS 6.22 25
Install Windows 3.1x 26
Post Installation Considerations for MS-DOS 6.22 and Windows 3.1x 26
VMware Tools in a MS-DOS 6.22 and Windows 3.1x Guest 26
Asianux Server 3.0 26
VMware Tools in a Asianux Server 3.0 Guest 27

VMware, Inc.



Guest Operating System Installation Guide

CentOS5 27

VMware Tools 28
CentOS4 28

VMware Tools in a CentOS 4 Guest 28
Debian5 28
Debian4 29
eComStation 1.0 29

VMware Tools in a eComStation 1.0 30
IBM OS/2 Warp 4.5.2 30

Create Boot Disks 31

VMware Tools in a IBM OS/2 Wrap 452 31
IBM OS/2 Warp 4.0 31

Create Boot Disks 32

VMware Tools in a IBM OS/2 Wrap 4.0 32

Mac OS X Server 10.5 and Mac OS X Server 10.6 32

Mandriva Corporate 4 33
Mandriva Linux 2009 33
Mandriva Linux 2008 34
Mandriva Linux 2007 35
Mandriva Linux 2006 36
Mandrake Linux 10 36
Mandrake Linux 9.x 37
Mandrake Linux 8.x 39
Set Up a Symbolic Link to XFree86 40
Novell Linux Desktop 9 40

Oracle Enterprise Linux 5 and Oracle Enterprise Linux 6 40

VMware Tools in an Oracle Enterprise Linux 5 and Oracle Enterprise Linux 6 Guest 41

Oracle Enterprise Linux 4 41

VMware Tools in an Oracle Enterprise Linux 4 Guest 42

Red Hat Enterprise Linux 6 42

VMware Tools in a Red Hat Enterprise Linux 6 Guest

Red Hat Enterprise Linux 5 42

VMware Tools in a Red Hat Enterprise Linux 5 Guest

Red Hat Enterprise Linux 4 43

VMware Tools in a Red Hat Enterprise Linux 4 Guest

Red Hat Enterprise Linux 3 44

VMware Tools in a Red Hat Enterprise Linux 3 Guest

Red Hat Enterprise Linux 2.1 46

VMware Tools in a Red Hat Enterprise Linux 2.1 Guest 47

Red Hat Linux 9.0 47

VMware Tools in a Red Hat Linux 9.0 Guest 48

Red Hat Linux 8.0 48

VMware Tools in a Red Hat Linux 8.0 Guest 49

Red Hat Linux 7 49

VMware Tools in a Red Hat Linux 7 Guest 50

Red Hat Linux 6.2 50
Sun Java Desktop System 2 51
SCO OpenServer 5.0 51

Install Maintenance Pack 5 53

VMware Tools in a SCO OpenServer 5.0 Guest 53

SCO UnixWare 7 53
Installing SCO UnixWare Maintenance Packs
Installing and Configuring SMP 54
VMware Tools in an SCO UnixWare 7 Guest

54

54

42

43

44

45

VMware, Inc.



Contents

SUSE Linux Enterprise 11 54
SUSE Linux Enterprise 10 54
SUSE Linux Enterprise Server 9 55
SUSE Linux Enterprise Server 8 55
SUSE Linux Enterprise Server 7 56
openSUSE Linux 11.x 56
VMware Tools in an openSUSE Linux 11.x Guest 57
openSUSE Linux 10.x 57
SUSE Linux10.x 58
SUSE Linux 9.x 58
Run SaX2 Configuration Utility 59
SUSE Linux 8.x 59
Run SaX2 Configuration Utility 59
SUSE Linux 7.3 60
VMware Tools in a SUSE Linux 7.3 Guest 60
Turbolinux 11 60
Turbolinux 10 61
Turbolinux 8 61
Turbolinux 7.0 62
VMware Tools in a Turbolinux 7.0 Guest 62
Ubuntu 10.04 and Ubuntu 10.10 62
VMware Tools in an Ubuntu 10.04 and Ubuntu 10.10 Guest 63
Enable Root in a Virtual Machine Running Ubuntu Server Edition 63
Ubuntu9.10 63
VMware Tools in an Ubuntu 9.10 Guest 63
Enable Root in a Virtual Machine Running Ubuntu Server Edition 64
Ubuntu 9.04 64
VMware Tools in an Ubuntu 9.04 Guest 64
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 64
Ubuntu 8.10 65
VMware Tools in an Ubuntu 8.10 Guest 65
Enable Root in a Virtual Machine Running Ubuntu Server Edition 65
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 65
Ubuntu 8.04 LTS 66
VMware Tools in an Ubuntu 8.04 LTS Guest 66
Enable Root in a Virtual Machine Running Ubuntu Server Edition 66
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 66
Ubuntu Linux 7.10 67
VMware Tools in an Ubuntu 7.10 Guest 67
Enable Root in a Virtual Machine Running Ubuntu Server Edition 67
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 67
Ubuntu Linux 7.04 68
VMware Tools in an Ubuntu 7.04 Guest 68
Enable Root in a Virtual Machine Running Ubuntu Server Edition 68
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 68
Ubuntu Linux 6.10 69
VMware Tools in an Ubuntu 6.10 Guest 69
Enable Root in a Virtual Machine Running Ubuntu Server Edition 69
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 69
Ubuntu Linux 6.06 70
VMware Tools in an Ubuntu 6.06 Guest 70
Enable Root in a Virtual Machine Running Ubuntu Server Edition 70
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 70
Ubuntu Linux 5.10 71

VMware, Inc. 5



Guest Operating System Installation Guide

VMware Tools in an Ubuntu 5.10 Guest 71
Enable Root in a Virtual Machine Running Ubuntu Server Edition 71
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition 71
VMware Tools and 64-bit Version of Ubuntu Linux 5.10 72
Ubuntu Linux 5.04 72
VMware Tools in an Ubuntu 5.04 Guest 72
FreeBSD 8 73
Known Limitation for FreeBSD 8 73
FreeBSD 7.x 73
VMware Tools in a FreeBSD 7.x Guest 73
FreeBSD 6.x 74
FreeBSD 5.x 74
FreeBSD 4.x 74
Installation Instructions for FreeBSD 4.11, 4.10, and 4.9 75
Installation Instructions for FreeBSD 4.3, 4.2, 4.1, and 4.0 75
Set the Disk Geometry Manually 75
NetWare 6.5 Server 76
VMware Tools in a NetWare 6.6 Server Guest 77
NetWare 6.0 Server 77
VMware Tools in a NetWare 6.0 Server Guest 79
NetWare 5.1 Server 79
VMware Tools in a NetWare 5.1 Server Guest 81
NetWare 4.2 Server 81
VMware Tools in a NetWare 4.2 Server Guest 83
Solaris 10 Operating System x86 Platform Edition 83
VMware Tools in a Solaris 10 Guest 83
Solaris 9 Operating System x86 Platform Edition 84
Configure the X Server 84
VMware Tools in a Solaris 9 Guest 85
Solaris 8 Operating System x86 Platform Edition 85
Configure the X Server 86
Adding a SCSI Driver 86
Creating an ITU Driver Disk Using Solaris 86
Detect the SCSI Hard Drive 87
VMware Tools in a Solaris 8 Guest 87

Index 89

6 VMware, Inc.



About This Book

The Guest Operating System Installation Guide provides users of VMware® ESX Server, VMware GSX Server,
VMware Server, VMware ACE, VMware Workstation, and VMware Fusion™ information about installing
guest operating systems in VMware virtual machines.

Revision History

This guide is revised with each newly supported guest operating system that requires installation instructions.

Table 1. Revision History
Revision Description

20110310 ®  Added knowledge base article information to install Boot Camp drivers on Windows 7,
Windows Vista, and Windows XP.
Added installation instructions for Oracle Enterprise Linux 6.

Added installation instructions for Mac OS X Server 10.6.

20110224 ®  Updated the ESX installation prerequisite for Oracle Enterprise Linux 5.
Added PVSCSI driver information for Windows 7 32-bit and 64-bit installation.

Removed minimum virtual machine disk requirements for Windows Server 2008 R2,
Windows Server 2008, and Windows Vista installation.

®m  Updated the installation prerequisites and added VMware Tools instructions for Red Hat
Enterprise Linux 6.

20110210 Removed minimum disk requirements for 32-bit and 64-bit Windows 7 installation.
Added Solaris 10 update 9 system requirements for VMware Server or ESX Server.
Added known installation limitation for FreeBSD 8.

Added installation instructions reference link from the FreeBSD site.

Added installation instructions for Red Hat Enterprise Linux 6.

Updated the installation instructions for SUSE Linux 8.x.

Added installation instructions for Ubuntu 10.10.

20100713

Added installation instructions for Ubuntu 10.04.

Added installation instructions for Turbolinux 11.

Removed incorrect statement about 64-bit Solaris 10 guests support only for the e1000
network adapter driver.

20100610 m  Added information about FreeBSD 8.
Condensed installation instructions for SUSE Linux 8.x.

Added instructions for operating systems that the operating system vendor no longer
supports.
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Table 1. Revision History (Continued)

Revision

20100304

Description

Added information about recommended memory size for Windows 95.

Added information about kernel panic error when installing 64-bit Red Hat Enterprise
Linux AS 4.0, 4.1, and 4.2 on a host with AMD NPT processor.

Removed incorrect instructions for enabling root on an Ubuntu Desktop 9.10 virtual
machine.

Condensed installation instructions for Desktop and Server releases for Linux guests,
including Mandriva Corporate 4, SUSE Linux Enterprise 11, SUSE Linux Enterprise 10,
Turbolinux 10, and Turbolinux 8.

Condensed installation instructions for Mandrake 9.x and 8.x.
Condensed installation instructions for RedHat Linux 7.x.

Condensed installation instructions for FreeBSD 7.x, 6.x, 5.x, and 4.x.

20100201

Modified hard drive requirements for a Windows 2008 r2 virtual machine.

Added information about support for the e1000 NIC driver for Windows XP on ESX 4.0
Update 1.

Added instructions for eComStation 1.0.
Added instructions for Mandriva 2009.

Revised guest selections for creating virtual machines on SUSE Linux Enterprise Server 10
and SUSE Linux Enterprise Server 9 with OES 1 and OES2 support.

Revised VMware Tools support for Solaris 10 Operating System for x86 Platforms.

20091119

Added new instructions for Windows Server 2008 r2, Oracle Enterprise Linux 4, Ubuntu 9.10,
and FreeBSD 7.2.

20090902

Revised installation instructions for MS-DOS 2.66 and MS-DOS 3.1x.

Modified instal instructions for SUSE Linux Enterprise Server 10 and 9 to use the GRUB
BootLoader instead of LILO.

Made minor edits to information for SUSE Linux Enterprise Server 10.

20090716

Reorganized the Guest Operating System Installation Guide to include information only
pertinent to installing supported guest operating systems. To find the information and
support data that was removed from this guide check these locations:

®  Guest Operating System Installation Guide (Deprecated) — for information that was
published in the guide prior to July 16, 2009.

®  Online Guest/Host OS VMware Compatibility Guide — for supported guest operating
system details and general information.

®  Knowledge Base — for known issues and problems that affected the operation of a
guest.

®  Product documentation - for VMware Tools instructions and information.

Intended Audience

This guide if for those responsible for installing operating systems on VMware virtual machines.

VMware Technical Publications Glossary

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions

of terms as they are used in VMware technical documentation go to http://www.vmware.com/support/pubs.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.
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About This Book

Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current version
of this book and other books, go to http://www.vmware.com/support/pubs.
Online and Telephone Support

To use online support to submit technical support requests, view your product and contract information, and
register your products, go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on
priority 1 issues. Go to http://www.vmware.com/support/phone_support.html.
Support Offerings

To find out how VMware support offerings can help meet your business needs, go to
http://www.vmware.com/support/services.

VMware Professional Services

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials
designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live
online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides
offerings to help you assess, plan, build, and manage your virtual environment. To access information about
education classes, certification programs, and consulting services, go to http://www.vmware.com/services.

VMware, Inc.
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Installing Guest Operating Systems

The Guest Operating System Installation Guide includes installation instructions for installing supported guest
operating systems on the following VMware products:

® VMware ESX Server 2.0 and later
B VMware ESXi/ESX 3.5 and later

®  VMware Workstation 4.0 and later
B VMware Server 1.0 and later

®  VMware Fusionl1.0 and later

®  VMware ACE 1.0 and later

B VMware GSX Server 3.0 and later

If you are using VMware® Workstation 3.x, VMware GSX Server 2.x, VMware ESX Server 1.x or an earlier
VMware product, see the user’s manual that came with your product for installation instructions for the guest
operating systems supported by that product.

Operating systems that are not included in this guide are not supported.

See “General Installation Instructions for All VMware Products” on page 13 for information that might apply
to the guest you are installing and see “Latest Updates” on page 11 for the most recent changes to this guide.

Latest Updates

Find the latest version of the guide on the VMware Web site at: http://www.vmware.com/support/pubs. Check
the date on the cover page to determine if your copy of the guide is current. These are the changes or updates
made to the Guest Operating System Installation Guide since it was last published.

B Added knowledge base article information to install Boot Camp drivers on Windows 7, Windows Vista,
and Windows XP. See “Windows 7” on page 14, “Windows Vista” on page 17, and “Windows XP” on
page 18.

B Added installation instructions for Oracle Enterprise Linux 6. See “Oracle Enterprise Linux 5 and Oracle
Enterprise Linux 6” on page 40.

B Added installation instructions for Mac OS X Server 10.6. See “Mac OS X Server 10.5 and Mac OS X Server
10.6” on page 32.

®  Updated the ESX installation prerequisite for Oracle Enterprise Linux 5. See “Oracle Enterprise Linux 5
and Oracle Enterprise Linux 6” on page 40.

B Added PVSCSI driver information for Windows 7 32-bit and 64-bit installation. See”Windows 7” on
page 14.

VMware, Inc. "
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Removed minimum virtual machine disk requirements for Windows Server 2008 R2, Windows Server
2008, and Windows Vista installation. See “Windows Server 2008 R2” on page 16, “Windows Server 2008”
on page 16, and “Windows Vista” on page 17.

Updated the installation prerequisites and added VMware Tools instructions for Red Hat Enterprise
Linux 6. See “Red Hat Enterprise Linux 6” on page 42.

Removed minimum virtual machine disk requirements for 32-bit and 64-bit Windows 7 installation. See
“Windows 7” on page 14.

Added Solaris 10 update 9 system requirements for VMware Server or ESX Server. See “Solaris 10
Operating System x86 Platform Edition” on page 83.

Added known installation limitation for FreeBSD 8. See “FreeBSD 8” on page 73.

Added installation instructions reference link from the FreeBSD site. See “FreeBSD 7.x” on page 73,
“FreeBSD 6.x” on page 74, “FreeBSD 5.x” on page 74, and “FreeBSD 4.x” on page 74.

Added installation instructions for Red Hat Enterprise Linux 6. See “Red Hat Enterprise Linux 6” on
page 42.

Updated the installation instructions for SUSE Linux 8.x. See “SUSE Linux 8.x” on page 59.

Added installation instructions for Ubuntu 10.10. See “Ubuntu 10.04 and Ubuntu 10.10” on page 62.
Added installation instructions for Ubuntu 10.04. See “Ubuntu 10.04 and Ubuntu 10.10” on page 62.
Added installation instructions for TurboLinux 11. See “Turbolinux 11” on page 60.

Removed incorrect statement about 64-bit Solaris 10 guests support only for the e1000 network adapter
driver. See “Solaris 10 Operating System x86 Platform Edition” on page 83.

Added installation instructions for FreeBSD 8. See “FreeBSD 8” on page 73.
Added information about recommended memory size for Windows 95. See “Windows 95” on page 23.

Added information about kernel panic error when installing 64-bit Red Hat Enterprise Linux AS 4.0, 4.1,
and 4.2 on a host with an AMD NPT processor. See “Red Hat Enterprise Linux 4” on page 43.

Removed incorrect instructions for enabling root on an Ubuntu Desktop 9.10 virtual machine. See
“Ubuntu 9.10” on page 63.

Condensed installation instructions for Desktop and Server releases for Linux guests, including
“Mandriva Corporate 4” on page 33, “SUSE Linux Enterprise 11” on page 54 and “SUSE Linux Enterprise
10” on page 54, “Turbolinux 10” on page 61 and “Turbolinux 8” on page 61.

Condensed installation instructions for Mandrake 9.x and 8.x. Start with “Mandrake Linux 9.x” on
page 37.

Condensed installation instructions for RedHat Linux 7.x. See “Red Hat Linux 7” on page 49.

Condensed installation instructions for SUSE Linux 10.x, 9.x, 8.x. Start with “SUSE Linux Enterprise 10”
on page 54.

Condensed installation instructions for FreeBSD 7.x, 6., 5.x, and 4.x. Start with “FreeBSD 7.x” on page 73.

Operating Systems That the Operating System Vendor No Longer Supports

For operating systems listed in this guide that the operating system vendor no longer supports, VMware
might, at its sole discretion, provide support and fixes to VMware products to address problems that are
exposed by running such operating systems on a VMware virtual machine. VMware is not responsible for
resolving problems with or providing support or fixes to the operating system itself.

VMware, Inc.



Installing Guest Operating Systems

General Guidelines for Supported Guests

Configurations, support, and hardware influence how you install a supported guest operating system.

Determining Memory Settings for a Virtual Machine

When you configure the memory settings for a virtual machine, you should consult the documentation for the
guest operating system you plan to run in that virtual machine. The user interface of your VMware product
provides general guidelines for the amount of memory required. If the interface and the operating system
documentation do not agree, you should rely on the operating system documentation.

Using Sound Adapters on GSX and VMware Servers

Sound adapters by default are not installed in a virtual machine for GSX or VMware Servers. To add a sound
adapter, use the virtual machine settings editor (VM > Settings) after you have installed the operating system.
For instructions on configuring sound for a virtual machine on a G5X or VMware Server, see the
corresponding server documentation.

Running a Guest Operating System

For information about running a guest operating system and using its features, see the documentation
provided by the operating system vendor.

64-Bit Linux Guests and Execute Disable Functionality

When running a 64-bit Linux guest operating system on EM64T hardware, make sure that you have Execute
Disable functionality enabled in the host BIOS. This functionality helps to ensure that the Linux guest
operating system runs without interruption.

VMware Tools

VMware Tools must be installed in most guest operating systems. For an overview of VMware Tools and for
a list of the manuals that contain installation instructions for VMware Tools, see knowledge base article 340 at
http://kb.vmware.com/kb/340.

General Installation Instructions for All VMware Products

Installing a guest operating system in a virtual machine is essentially the same as installing it on a physical
computer.

Before installing a guest operating system, create a virtual machine and ensure that its devices are setup
correctly. For example, install networking software when you install the guest operating system, and configure
and enable the Ethernet adapter for the virtual machine.

The tool or interface you used to configure the virtual machine depends on the VMware product you are
running.

A new virtual machine is like a physical computer with a blank hard disk. Before you can use it, you must
partition and format the virtual disk and install an operating system. The operating system installation
program might handle the partitioning and formatting steps for you.

NOTE You should disable screen savers that might be running on the host system before you install the guest
operating system.

VMware, Inc. 13
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Typical Installation

The basic steps to install a typical operating system:
1  Start your VMware product and connect to the virtual machine.

2 Insert the installation CD-ROM or disc of the guest operating system in to the CD-ROM or disc drive
connected to the virtual machine.

m  ESX Server 2.x. You must insert the installation CD-ROM or disc in the drive on the server where the
virtual machine is running. You cannot use the drives on the management workstation.

B GSX Server. If your guest operating system requires a disc, you must insert it in the drive on the
server where the virtual machine is running. You cannot use the disc drive on the management
workstation.

3 Turn on your virtual machine by clicking Power On.
4  Follow the instructions provided by the operating system vendor.

As with physical computers, operating systems require separate licenses for each virtual machine that you
run.

Some Microsoft Windows OEM discs included with new computers are customized for those computers
and include device drivers and other utilities specific to the hardware system. Even if you can install that
Windows operating system on your physical computer, you might not be able to install it in a virtual
machine. You might need to purchase a new copy of Windows to install in a virtual machine.

5 Install VMware Tools.

ISO Installation

Rather than booting from a physical CD-ROM, you can create an ISO image file from the installation CD-ROM.
You can store the ISO file on the host machine or on a network drive accessible from the host machine. Use the
configuration tool for your VMware product to connect the virtual machine CD drive to the ISO image file,
and turn on the virtual machine.

Using an ISO image file is convenient to install the same operating system in multiple virtual machines. It can
also help you avoid a problem in host configurations, in which the virtual machine cannot boot from the
installation CD-ROM.

PXE Installation

If you plan to use a PXE server to install the guest operating system over the network, you do not need the operating
system installation media. When you turn on the virtual machine, the virtual machine detects the PXE server.

PXE booting is supported for guest operating systems that are listed in the VMware Guest Operating System
Compatibility list and whose operating system vendor supports PXE booting of the operating system.

Windows 7

14

Install Windows 7 in a virtual machine using the corresponding Windows 7 distribution CD.
Before you begin, verify that the following tasks are complete:

B Read “General Guidelines for Supported Guests” on page 13.

B Create and configure a new virtual machine.

B Virtual machine. 1GB or more of RAM for 32-bit guests and 2GB or more of RAM for 64-bit guests.

Installation Steps

1 Insert the Windows 7 CD or DVD in the CD-ROM drive.

2 Turn on the virtual machine to begin installing Windows 7.

VMware, Inc.



Installing Guest Operating Systems

(Optional) If you are using VMware Paravirtual as the default SCSI controller, you can install Windows 7
32-bit using pvscsi-windows2003. flp driver and Windows 7 64-bit using pvscsi-windows2008.f1lp
driver.

Follow the prompts to complete the installation.
Install VMware Tools.

(Optional) On VMware Fusion, install Boot Camp drivers so that the guest operating system can access
hardware devices on the physical machine.

Windows 7 32- bit supports only Boot Camp 3 drivers and Windows 7 64-bit requires Boot Camp drivers
to be installed individually.

Refer to knowledge base article 1012885 at http://kb.vmware.com/kb/1012885 for more information.

Windows Preinstallation Environment

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

Create and configure a new virtual machine. During virtual machine creation, select Windows Vista for
the guest operating system. A Windows PE selection is not available.

Download and install Windows AIK 1.1 (WAIK1.1) software (build from Windows Server 2008 kernel)
from the Microsoft Web site:

http://www.microsoft.com/downloads/details.aspx?familyid=94BB6E34-D890-4932-81 A5-5B50C657DEQ
8&displaylang=en

Create a Windows PE 2.1 ISO image.

To Create a Windows PE 2.1 ISO Image

1

Select Start > All Programs > Microsoft Windows AIK > Windows PE Tools Command Prompt to open
the Windows PE Tools Command Prompt.

Type one of the following commands to create a Windows PE build environment for an x86 or amd64
machine in the winpe-x86 folder.

Platform Command
32-bit copype x86 C:\Winpe-x86
64-bit copype amd64 C:\Winpe-amd64

Create a Windows PE 2.1 bootable ISO image by entering the following command:

oscdimg -n —-h -bc:\winpe-x86\etfsboot.com c:\winpe-x86\iso c:\winpe-x86\winpe-x86.iso

Installation Steps

1

2

Boot the virtual machine from a Windows PE 2.1 ISO image.
After the boot process completes, a command prompt appears.

Use Windows PE to prepare your virtual machine to install a Windows operating system.

VMware Tools Support in Windows Preinstallation Environment

VMware Tools does not support Windows Preinstallation Environment.

VMware, Inc.
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Windows Recovery Environment

Read “General Installation Instructions for All VMware Products” on page 13.

For instructions specific to the Windows Recovery Environment, see the accompanying operating system
documentation.

VMware Tools in Windows Recovery Environment

There is no version of VMware Tools that supports Windows Recovery Environment.

Windows Server 2008 R2

You can install the Windows Server 2008 R2 in a virtual machine using the Windows Server 2008 R2
distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine.

Virtual machine. 512MB or more of RAM.

Host computer. 512MB or more of RAM.

Installation Steps

1
2
3
4

Insert the Windows Server 2008 R2 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows Server 2008 R2.
Follow the prompts to complete the installation.

Install VMware Tools.

Windows Server 2008

You can install the Windows Server 2008 in a virtual machine using the Windows Server 2008 distribution CD.

16

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine.

Virtual machine. 512MB or more of RAM.

Host computer. 512MB or more of RAM.

Consider these support and configuration issues for Windows Server 2008:

If an Internet connection is not available while installing a 32-bit Windows Server 2008 guest, the driver
for the multimedia audio controller will not be installed. The Windows Device Manager will indicate that
the driver for the multimedia audio controller is missing. To install the required driver, configure an
Internet connection, and run Windows Update on the Windows Server 2008 virtual machine.

ESX supports the Server Core role available in the Standard, Datacenter, and Enterprise editions of
Windows 2008 Server. VMware Tools still apply, unless Server Core disables parts of the operating system
that are specifically supported by VMware Tools. See the Microsoft Developer Network Web site for more
information about Server Core: http://msdn.microsoft.com/en-us/library/ms723891(VS.85).aspx

Installation Steps

1
2

Insert the Windows Server 2008 CD in the CD-ROM drive.

Power on the virtual machine to start installing Windows Server 2008.

VMware, Inc.
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Installing Guest Operating Systems

Follow the prompts to complete the installation.

Install VMware Tools.

Windows Vista

You can install Windows Vista in a virtual machine using the corresponding Windows Vista distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine.

Virtual machine. 512MB or more of RAM.

Host computer. 512MB or more of RAM.

Installation Steps

1
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Insert the Windows Vista CD in the CD-ROM drive.

Power on the virtual machine to start installing Windows Vista.
Follow the prompts to complete the installation.

Install VMware Tools.

(Optional) On VMware Fusion, install Boot Camp drivers so that the guest operating system can access
hardware devices on the physical machine.

Refer to knowledge base article 1012885 at http://kb.vmware.com/kb/1012885 for more information.

After installation, consider the following support and configuration issues for a Windows Vista guest.

Missing Multimedia Audio Controller in a Windows Vista Guest

If an Internet connection is not available while installing a 32-bit Windows Vista guest, the driver for the
multimedia audio controller is not installed. The Windows Device Manager indicates that the driver for the
multimedia audio controller is missing. To install the required driver, configure an Internet connection, and
run Windows Update on the Windows Vista virtual machine.

Screen Resolution in a Windows Vista Guest

After installing VMware Tools on a Windows Vista Service Pack (SP1) virtual machine, the screen resolution
does not change to 1024 by 768 pixels automatically. See VMware Knowledge Base article 1004780 at
http://kb.vmware.com/kb/1004780 for information on modifying the screen resolution manually.

Windows Server 2003

You can install Windows Server 2003 in a virtual machine using the corresponding Windows Server 2003
distribution CD.

Before you begin, verify that the following tasks are complete:

VMware, Inc.

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine.

If you are using the virtual LSI Logic SCSI adapter, Windows Server 2003 installs the SCSI driver when you
install the guest operating system. If you are using the virtual BusLogic SCSI adapter, you need a special
SCSI driver available from the download section of the VMware Web site at www.vmware.com/download.
Follow the instructions on the Web site to use the driver with a fresh installation of Windows Server 2003.
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If you have a virtual machine with a SCSI virtual disk and an earlier Windows guest operating system and
want to upgrade it to Windows Server 2003, install the new SCSI driver before upgrading the operating system.

Manually configure the 1000 network adapter driver in ESX 3.0.2 to support Windows Server 2003
Datacenter Edition. Refer to knowledge base article 1003020 at http://kb.vmware.com/kb/1003020.

Installation Steps

1
2
3

4
5

Insert the Windows Server 2003 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows Server 2003.

If you are using the virtual BusLogic SCSI driver downloaded from the VMware Web site, you must add
an additional driver.

a  Asthe Windows Server 2003 installer loads, press the F6 key.
This allows you to select the additional SCSI driver required for installation.
b Press S to specify the additional driver.
¢ Press Enter to continue with the installation.
Follow the prompts to complete the installation.

Install VMware Tools.

After installation, consider the following support and configuration issues for a Windows Server 2003 guest.

Missing Multimedia Audio Controller in a Windows Server 2003 Guest

If an Internet connection is not available while installing a Windows Server 2003 guest, the driver for the
multimedia audio controller is not installed. The Windows Device Manager indicates that the driver for the
multimedia audio controller is missing. To install the required driver, configure an Internet connection, and
run Windows Update on the Windows Server 2003 virtual machine.

Windows XP

You can install Windows XP Home Edition or Professional in a virtual machine using the corresponding
Windows XP distribution CD.

Before you begin, verify that the following tasks are complete:

18

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine

ESX, VMware Workstation, VMware ACE, and GSX Server. To use the virtual BusLogic SCSI adapter in
a Windows XP virtual machine, you need a special SCSI driver available from the download section of the
VMware Web site at www.vmware.com/download. Follow the instructions on the Web site to use the
driver with a fresh installation of Windows XP.

ESX and GSX Server. If you are using the virtual LSI Logic SCSI adapter in a Windows XP virtual
machine, download the driver from the download center at the LSI Logic Web site. Go to
http://www.lsi.com/cm/DownloadSearch.do?locale=EN and download the LSI20320-R SCSI adapter
driver for your guest operating system.

The LSI Logic Web site also provides a guide for installing the drivers. Go to http://www.Isi.com/.
Select Support & Downloads > Documentation. Enter the search term Fusion MPT to find the Fusion-MPT
Device Management User Guide.

VMware, Inc.
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ESX. You can use the vmscsi SCSI driver for the virtual BusLogic SCSI adapter provided on the Windows
XP Professional floppy image that is included with the ESX software. Although supported by ESX 4.0
Update 1, the e1000 NIC driver is not provided with the 32-bit version of Windows XP Professional.

For support, download the driver from the Intel Web site. See knowledge base article 1016456 at
http://kb.vmware.com/kb/1016456.

If you have a virtual machine with a SCSI virtual disk and an earlier Windows guest operating system,
and want to upgrade the virtual machine to Windows XP, install the new SCSI driver before upgrading
the operating system.

Installation Steps

1
2
3

Insert the installation CD in the CD-ROM drive.
Power on the virtual machine to start installing the guest operating system.

If you are using the virtual BusLogic SCSI driver downloaded from the VMware Web site or the LSI Logic
SCSI driver downloaded from the LSI Logic Web site, you must install an additional driver.

a  Asthe Windows XP installer loads, press the F6 key.
This allows you to select the additional SCSI driver required for installation.
b Press S to specify the additional driver, and press Enter to continue with the installation.
Follow the prompts to complete the installation.
Install VMware Tools.

(Optional) On VMware Fusion, install Boot Camp drivers so that the guest operating system can access
hardware devices on the physical machine.

Refer to knowledge base article 1012885 at http://kb.vmware.com/kb/1012885 for more information.

Windows 2000

You can install a supported version of Windows 2000 in a virtual machine using the corresponding
Windows 2000 distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine.

ESX Server, VirtualCenter, or vCenter Server. If you are using the virtual LSI Logic SCSI adapter, you
must download the driver from the download center at the LSI Logic Web site. Go to
http://www.lsi.com/cm/DownloadSearch.do?locale=EN and download the LSI20320-R SCSI adapter
driver for your guest operating system.

Installation Steps

1
2
3
4

Insert the Windows 2000 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows 2000.
Follow the prompts to complete the installation.

Install VMware Tools.

VMware Tools in a Windows 2000 Guest

After you install VMware Tools in a Windows 2000 guest, change the Windows 2000 screen area to be greater
than 640x480 pixels. If you do not change it, Windows 2000 uses the standard VGA driver, and performance
will suffer.

VMware, Inc.
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Windows NT 4.0

You can install Windows NT 4.0 (Workstation or Server) in a virtual machine using the standard Windows NT CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Create and configure a new virtual machine.

To set up a virtual machine running Windows NT 4.0 and using multiple disks, you must first create a
virtual machine with only one disk. Install Windows NT on that disk. Then use the configuration tools in
your VMware product to add the additional disks.

If you have a Windows NT 4.0 guest with a SCSI virtual disk, you cannot add both an additional SCSI disk
and an IDE disk to the configuration.

If you intend to run a Windows NT virtual machine with IDE virtual disks on a multiprocessor host
computer, you might notice slower than expected disk input/output performance. For more information,
see Disk Performance in Windows NT Guests on Multiprocessor Hosts in the GSX Server documentation.

Installation Steps

1
2
3
4

Insert the Windows NT 4.0 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows NT 4.0.
Follow the prompts to complete the installation.

Install VMware Tools.

After installation, consider the following configurations.

Enable DMA Transfer Support

Virtual disks support DMA transfers for better performance. You can enable DMA after installing Windows
NT 4.0. DMA is always enabled on SCSI virtual disks.

Before you begin, verify that the following task is complete:

The NT Service Pack 3 or 4 CD is required to enable this option.

To Enable DMA Transfer Support

1
2
3

Power on the virtual machine.
Insert the SP3 or SP4 CD in the drive.

Run DMACHECK . EXE from the \SUPPORT\UTILS\I386 folder on the CD and click Enabled for the IDE
controller and channel that is configured with the virtual disk.

Typically, the controller and channel is channel 0, unless the virtual machine is configured with multiple
virtual disks.

(Optional) If you have a virtual disk and a CD-ROM attached as master and slave to the primary IDE
controller (channel 0) and you want to enable DMA, power off the virtual machine and use the
Configuration Editor to move the CD-ROM to the secondary IDE controller (channel 1) at IDE 1:0. Then
boot the virtual machine with Windows NT, run DMACHECK and enable DMA for channel 0 only.

CAUTION Do not enable DMA for any IDE channel that has a CD-ROM drive configured for it. Enabling
DMA for such a configuration causes an error.
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Enabling Networking After Installing Windows NT 4.0

If networking was disabled at the time you installed Windows NT, you can enable it after installing the
operating system.

Before you begin, verify that the following tasks are complete:
®  Shut down Windows NT and power off the virtual machine.

B Add the network adapter to the virtual machine’s configuration.

To Install the Network Driver in the Windows NT Guest OS

1  Power on the virtual machine.

2 While Windows NT is booting, insert the Windows NT 4.0 CD in the CD-ROM drive.

3 Log on to Windows NT and install the AMD PCNET driver.
a  Open the Network properties page by double-clicking the Network icon in Control Panel.
b Click the Adapters tap to change to the Network Adapters screen.
¢ Click Add and select AMD PCNET Family Ethernet Adapter.

d  Specify the \1386 folder on the CD in the path you enter (for example, type D:\1386 if the CD is in
drive D).

e Click Continue.
Windows NT setup prompts you for the Windows NT files again.
f  Click Continue.

g  Use the default adapter settings. Windows NT setup prompts you again for a path to the
Windows NT files.

h  Click Continue to finish installing the driver.

VMware Tools in a Windows NT 4.0 Guest

To view VMware Tools online help in a Windows NT 4.0 guest, Windows NT 4.0 must have Internet Explorer 4.0
or greater installed.

Windows Me

You can install Windows Millennium Edition in a virtual machine using the standard Windows Me CD.
Before you begin, verify that the following tasks are complete:

B Read “General Installation Instructions for All VMware Products” on page 13.

®  Create and configure a new virtual machine.

B The recommended memory size for Windows Me is 64MB. If you use more than 512MB, you might
encounter problems. Consult the Microsoft Web site for a workaround. See
http://support.microsoft.com/default.aspx?scid=kb;EN-US;253912

Installation Steps

1  Insert the Windows Me CD in the CD-ROM drive.

2 Power on the virtual machine to start installing Windows Me.
3 Choose to boot from CD-ROM.

4  Select Start Windows Me Setup from CD-ROM.

The setup program runs FDISK and reboots.
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Choose to boot from CD-ROM again.

Select Start Windows Me Setup from CD-ROM.

The setup program continues installing Windows Me.
Follow the prompts to complete the installation.

Install VMware Tools.

Windows 98

You can install Windows 98 in a virtual machine using the standard Windows 98 CD.

22

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

The recommended memory size for Windows 98 is 64MB. If you use more than 512MB you might
encounter problems. Consult the Microsoft Web site for a workaround. See
http://support.microsoft.com/default.aspx?scid=kb;EN-US;253912

Installation Steps

1
2

6
7

Insert the Windows 98 CD in the CD-ROM drive.

If you have a Windows 98 package that requires that you boot from a floppy disk, insert the boot floppy
in the floppy disk drive.

a Follow the on-screen instructions.
b Run FDISK and FORMAT when the installer prompts you to do so
Power on the virtual machine.

Choose to boot from CD-ROM, and then select the option Start Windows 98 Setup from CD-ROM. The
setup program runs FDISK and reboots.

Once again, choose to boot from CD-ROM, and then select the option Start Windows 98 Setup from
CD-ROM. The setup program continues installing Windows 98.

Follow the prompts to complete the installation.

Install VMware Tools.

After installation, consider the following configuration.

Enabling Networking After Installing Windows 98

If networking was disabled at the time you installed Windows 98, you can enable it after the operating system
has been installed.

To Enable Networking After Installing Windows 98

1
2
3

Power off the virtual machine.
Add a network adapter to the configuration.
Power on the virtual machine.

Windows 98 automatically detects an AMD PCNET Family Ethernet Adapter (PCI-ISA) and prompts the
Windows 98 CD-ROM to install drivers. The default Ethernet adapter settings typically do not need to be
changed.

You can use the Network icon in the Windows 98 Control Panel to view or change network settings.
For example, you might want to add the TCP/IP protocol since Windows 98 does not install it by default.
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Windows 95

You can install Windows 95 in a virtual machine using a standard Windows 95 boot floppy and CD-ROM.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

The recommended memory size for Windows 95 is 64MB. If you use more than 512MB you might
encounter problems. Consult the Microsoft Web site for a workaround. See
http://support.microsoft.com/default.aspx?scid=kb;EN-US;253912

You must run the FDISK and FORMAT utilities on the virtual hard disk drives before running Windows 95
setup. (Some Windows 95 distributions provide instructions that do not include the steps to FDISK and
FORMAT a C: drive.)

The installation instructions are for the simplest case of one virtual IDE hard drive and one virtual IDE
CD-ROM drive. If you configured the virtual machine with more than one IDE hard drive, run FDISK and
FORMAT utilities on these drives before installing Windows 95. If you configured the virtual machine with
more than one virtual hard drive or more than one virtual CD-ROM, you might need to use device letters
that are different from those in the instructions.

Installation Steps

1

VMware, Inc.

Insert the Windows 95 CD-ROM Setup Boot Disk in floppy drive A: used by your virtual machine and
insert the Windows 95 CD in the CD-ROM drive.

Power on the virtual machine.

After the virtual machine boots, if you are presented with a choice of CD-ROM drivers, select the first IDE
driver option available (even if your computer has a SCSI CD-ROM drive).

Partition the virtual disk.
A:\> FDISK
Answer the questions.

If you create a primary partition that is smaller than the full size of the virtual disk, mark the partition as
active.

Reboot Windows 95.

a  If the cursor is not already within the virtual machine window;, click in the virtual machine display,
and then press Ctrl+Alt+Ins on a Windows host or Ctrl+Alt+Del on a Linux host.

b If prompted on reboot to select a CD-ROM driver, select the first IDE CD-ROM driver from the list.
Format the C: drive.

A:\> FORMAT C: /S

Start the Windows 95 installation.

A:\> D:\WIN9S\SETUP /IS
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10 If the virtual machine’s Ethernet adapter is enabled, manually add an Ethernet driver because Windows 95
does not detect it during the Analyzing Computer phase (even if you selected the Network Adapter
detection option).

a  Continue with the Windows 95 installation until you get to the Windows 95 Setup Wizard/Setup
Options screen. Change the default setting from Typical to Custom and click Next to continue.

b From the Network Configuration screen, click Add, select the Adapter component, select Advanced
Micro Devices from the manufacturer window and AMD PCNET Family Ethernet Adapter
(PCI&ISA) from the network adapter window.

¢ If you need TCP/IP networking, add it from the Network Configuration screen (Windows 95 Setup
does not enable TCP/IP by default).

CAUTION If you do not do this, the first phase of the Windows 95 installation does not copy some of the files
it will need later, and the entire installation fails.

11  Verify that the Microsoft NetBEUI protocol is installed. It might not be installed by default.
12  Finish the Windows 95 installation.
13 Install VMware Tools.

After installation, consider the following configurations.

Enable DMA Transfers

VMware virtual disks support DMA transfers for better performance. The feature can be enabled after you
have installed Windows 95 on a virtual IDE disk.

To Enable DMA Transfers

1  Right-click My Computer and select Properties.

From the System Properties dialog box, click the Device Manager tab.
Double-click the Disk Drives device category.

Double-click the GENERIC IDE DISK TYPEO1 device.
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Click the Settings tab and select the DMA check box.

Enable Networking After Windows 95 Installation in a Virtual Machine

If networking was disabled at the time you installed Windows 95, you can enable it after installing the
operating system. Shut down Windows 95 and power off the virtual machine. Add the network adapter to the
virtual machine’s configuration, and install the network driver in the Windows 95 guest operating system.

To Enable Networking After Windows 95 Installation in a Virtual Machine
1  Power on the virtual machine.

When Windows 95 reboots, it auto-detects an AMD PCNET Family Ethernet Adapter (PCI&ISA) and
prompts for the Windows 95 CD-ROM to install drivers.

2 Accept he default Ethernet adapter settings.
3 Double-click the Network icon in the Control Panel to view or change network settings.

For example, you might want to add the TCP/IP protocol because Windows 95 does not install it by
default.
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Troubleshooting Windows 95 Installations in a Virtual Machine

An intermittent problem can occur during Windows 95 installations in a virtual machine. Shortly after the
Windows 95 Setup program is started, Scandisk runs to completion, and when the Windows 95 Setup program
should start its graphical user interface, the virtual machine returns to an MS-DOS prompt. Reboot the virtual
machine and rerun Windows 95 Setup. You do not need to run the FDISK or FORMAT utilities on the drive again.
If this problem occurs and it is reproducible, report it to VMware technical support.

MS-DOS 6.22 and Windows 3.1x

Before you begin, verify that the following tasks are complete:

B Read “General Installation Instructions for All VMware Products” on page 13.
B A new configured virtual machine.

m  Full version of the Microsoft MS-DOS 6.22 installation disks.

®  Windows 3.1x standard installation disks.

B CD-ROM drivers. By default the OAKCDROM. sys driver is provided with MS-DOS startup disks. You can
also use other drivers that are available to you, for example AOATAPI.SYS, or else you can download

drivers from the web. These drivers are typically loaded at system startup by making a series of entries in
the C:\CONFIG.SYS and C:\AUTOEXEC.BAT machine files.

Install MS-DOS 6.22

You can install MS-DOS 6.22 in a virtual machine using the Microsoft full-version MS-DOS 6.22 installation
disks. If you have the upgrade disks, you must install an earlier version of MS-DOS 6.22 before you upgrade.

NOTE The HIMEM. SYS file is included with MS-DOS and enables upper memory for MSCDEX. EXE.

The following articles provide information for configuring networking in a DOS 6.22 environment:
B Load DOS Network drivers in virtual machine — http://communities.vmware.com/message/109168

®  Create a VMware Workstation Network Boot Disk — http://communities.vmware.com/message/38060

To install MS-DOS 6.22

1 Insert the MS-DOS disk into the disk drive.

2 Power on the virtual machine and begin installing MS-DOS.

3 After the installation is complete, reboot the guest.
The command prompt appears.

4 Verify that the following files are installed in the root directory of the boot device:
MSCDEX. EXE, AUTOEXEC. BAT, and CONFIG.SYS file in C:\

5 Copy the OAKCDROM. SYS CD-ROM driver file to a disk.

6  Insert the disk with the driver file in the disk drive and connect it to the guest from the VM > Settings
menu.

7 From the command prompt, copy the contents from drive A to drive C.
A:\OAKCDROM. SYS C:DOS\

8  Open the MS-DOS AUTOEXEC. BAT file and add the following line:
LH C:\DOS\MSCDEX.EXE /D:mscd601l /1:D

9  Save the file and exit.
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10 Open the CONFIG.SYS file and add the following lines:

DEVICE=C:\DOS\HIMEM.SYS
DEVICEHIGH=C:\DOS\oakcdrom.sys /D:mscd001l
LAST DRIVE=Z

11 Save the file and exit.
12 Restart the MS-DOS 6.22 virtual machine.

As the installation configures the AUTOEXEC. BAT and CONFIG. SYS files, the CD-ROM drive appears in the
guest.

Install Windows 3.1x

VMware Workstation, VMware ACE, and GSX Server virtual machines support the networking features found
in Windows 3.11 (or Windows for Workgroups). After installation, select the Advanced Micro Devices
PCNET Family (NDIS2/NDIS3) Ethernet driver for the networking option.

The following articles provide information for configuring networking in a Win 3.1x environment:
B Load DOS Network drivers in virtual machine — http://communities.vmware.com/message/109168

®  Create a VMware Workstation Network Boot Disk — http://communities.vmware.com/message/38060

To install Windows 3.1x

1  Insert the Windows 3.1x Standard Installation Disks into the disk drive. and connect it to the guest from
the VM > Settings menu.

2 Run the SETUP program.
3 Follow the prompts to complete the installation.

4 When the installation completes, restart the guest.

Post Installation Considerations for MS-DOS 6.22 and Windows 3.1x

After you install MS-DOS 6.22, VMware recommends that you install a CPU idle program in the virtual
machine. Most versions of MS-DOS 6.22 do not idle the CPU when they are idle. As a result, when you run
MS-DOS 6.22 in a virtual machine, the virtual machine takes up CPU time on the host even when MS-DOS 6.22
is idle. VMware products rely on the guest operating system to use the Halt instruction or advanced power
management to unschedule the virtual machine when it is idle.

Run Windows 3.1x in full screen mode to avoid intermittent and erratic mouse behavior.

VMware Tools in a MS-DOS 6.22 and Windows 3.1x Guest

No VMware Tools package exists for MS-DOS 6.22 or Windows 3.1x guest operating systems. As a result,
Windows 3.1x is limited to VGA mode graphics, and you must always use the Ctrl+Alt key combination to
release the mouse from a MS-DOS 6.22 or Windows 3.1x virtual machine.

Asianux Server 3.0

The easiest method of installing Asianux Server 3.0 in a virtual machine is to use the standard Asianux
distribution CD. Installing Asianux 3.0 via the boot floppy/network method is also supported.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

®  Create and configure a new virtual machine.
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Installation Steps

1
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Insert the Asianux Server 3.0 CD-ROM in the CD-ROM drive.

Power on the virtual machine to start installing Asianux Server 3.0.

Follow the prompts to complete the installation.

In the Package Group Selection screen, choose Software Development and select individual packages.

In the Individual Package Selection screen, use the arrow keys to navigate to System
Environment/Kernel and press Enter.

Verify that kernel-smp is deselected. No asterisk should appear between the brackets. The SMP kernel is
not supported in a virtual machine. You do not need to change any other selections.

Select Automatic Partitioning screen, or partition the virtual disk manually if you do not want to use the
Asianux defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It means that the virtual hard drive in your virtual machine must be partitioned and formatted.

Click Yes to partition the drive.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can choose one of the following options.

m  Select Use bootp/dhcp.
B Set the networking parameters manually.

Install VMware Tools.

VMware Tools in a Asianux Server 3.0 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

CentOS 5

The easiest method of installing CentOS 5 in a virtual machine is to use the standard CentOS distribution CD.
Installing CentOS 5 via the boot floppy/network method is also supported.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

If available, select CentOS 4/5 (32-bit) or CentOS 4/5 (64-bit) option for the guest operating system when
creating the virtual machine, otherwise select Red Hat Enterprise Linux 5 (32-bit) or Red Hat Enterprise
Linux 5 (64-bit).

Use the LSI Logic SCSI adapter. CentOS 5 does not include a driver for the BusLogic SCSI adapter.

On a Linux host with an XFree86 3.x X server, do not run a screen saver in the guest operating system.
Guest screen savers that demand a lot of processing power can cause the X server on the host to freeze.

Installation Steps

1
2
3
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Insert the CentOS 5 CD-ROM in the CD-ROM drive.

Power on the virtual machine to start installing CentOS 5.
Follow the prompts to complete the installation.

Do not select the Virtualization Option during the installation.

Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.
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Select Automatic Partitioning, or partition the virtual disk manually if you do not want to use the CentOS
defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

Click Yes to partition the drive.

Install VMware Tools.

VMware Tools

Do not start the X server in the guest operating system until you install VMware Tools.

CentOS 4

The easiest method of installing CentOS 4 in a virtual machine is to use the standard CentOS distribution CD.
You can also install CentOS 4 with the boot floppy/network method.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

If available, select CentOS 4/5 (32-bit) or CentOS 4/5 (64-bit) option for the guest operating system when
creating the virtual machine, otherwise select Red Hat Enterprise Linux 4 (32-bit) or Red Hat Enterprise
Linux 4 (64-bit).

Select the LSI Logic SCSI adapter. CentOS 4 does not include a driver for the BusLogic SCSI adapter.

Installation Steps

1
2
3

Insert the CentOS 4 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing CentOS 4.
Follow the prompts to complete the installation.

Select Automatic Partitioning, or partition the virtual disk manually if you do not want to use the CentOS
defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

Click Yes to partition the drive.

Install VMware Tools.

VMware Tools in a CentOS 4 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Debian 5

The easiest method of installing Debian 5 in a virtual machine is to use the standard Debian 5 distribution CD.

Before you begin, verify that the following tasks are complete:
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Read “General Installation Instructions for All VMware Products” on page 13.
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With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Debian 5 CD in the CD-ROM drive.
Power on the virtual machine.
Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes

When the installation completes, in the Debian 5 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

Install VMware Tools using the tar installer.

Debian 4

The easiest method of installing Debian 4 in a virtual machine is to use the standard Debian 4 distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Debian 4 CD in the CD-ROM drive.
Power on the virtual machine to start installing Debian 4.
Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes

When the installation completes, in the Debian 4 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

Install VMware Tools using the tar installer.

eComStation 1.0

The easiest method of installing eComStation 1.0 in a virtual machine is to use the standard eComStation 1.0
distribution CD.

Before you begin, verify that the following tasks are complete:
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Read “General Installation Instructions for All VMware Products” on page 13.

When configuring the virtual machine, select eComStation for the Guest Operating System version in the
New Virtual Machine Wizard. If this selection is not available, select OS/2 or Other.

If you have access to eComStation 1.2R in the pre-boot menu, you can select the IBM IDE driver instead
of the DANIS506 driver. The DANIS506 IDE driver might not function correctly in an eComStation virtual
machine.
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Installation Steps

1 Insert the eComStation 1.0 CD in the CD-ROM drive.

2 Power on the virtual machine to start installing eComStation 1.0.
3 Follow the prompts to complete the installation.

4  After you power on eComStation 1.0, instead of booting the installation disk with the default values, select
boot with menu for own values.

5 Page down to the BOOT OPTIONS: Storage page.
6  Use the up arrow key to select IBM1S506/IBMATAPI for the (E) IDE/ATA(PI) controller.

7 Press F10 and press Enter to save these options and continue the boot process.

VMware Tools in a eComStation 1.0

VMware Tools does not support eComStation 1.0.

IBM OS/2 Warp 4.5.2
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The easiest method of installing IBM OS/2 Warp 4.5.2 in a virtual machine is to use the standard
distribution CD.

Before you begin, verify that the following tasks are complete:

B Read “General Installation Instructions for All VMware Products” on page 13.

®  Configure OS swap with at least 120MB of space.

®  Have the OS/2 Warp 4.5.2 boot disk CD and the OS/2 Warp 4.5.2 install CD available.
Consider these support and configuration issues for IBM OS/2 Warp 4.5.2:

®  Additional disks should be less than or equal to 528MB.

®  Additional disks have to be of the same type already in use by the virtual machine. For example, if an IBM
OS/2 Warp guest is installed on a BusLogic disk, any additional disks should also be BusLogic disks. The
same is true for LSI Logic and IDE.

Installation Steps

1  Insert the OS/2 Warp 4.5.2 boot disk in the CD drive.

2 Power on the virtual machine to start installing IBM OS/2 Warp 4.5.2.
3  Make sure Boot from CDROM Drive is enabled in the BIOS settings.

4  After installing the required drivers from the boot disk CD, insert the OS/2 Warp 4.5.2 install CD into the
CD drive.

5  Press the F3 key to use the command line interface to partition the hard drive.
6  Partition the hard disk drive using the FDISK utility.
Create an appropriate start volume on which to install the guest, and save the FDSIK settings.
7 Reinsert the OS/2 Warp 4.5.2 boot disk in the CD drive and reboot the guest.
8  After the initial startup completes, insert the OS/2 Warp 4.5.2 install CD in the CD drive.
The start volume appears on the screen.
9  Select an appropriate volume to install the guest.

10 Format the file system with File Allocation Table (FAT) File System or High Performance File System (HPFS).
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11 Continue the installation by selecting components, utilities, and other resources.

12 After completing the installation, reboot the guest.

Create Boot Disks

Create boot disks from the 32-bit OS/2 Warp 4.5.2 install CD, using the CDINST utility on a running OS/2
Warp 4.5.2 guest.

To Create Boot Disks

1
2
3
4

Power on a system in which 32-bit OS/2 Warp 4.5.2 is installed.

Insert the 32-bit OS/2 Warp 4.5.2 install CD into the CD drive.
Double-click on the CDINST utility that is located in the root directory.
Insert blank disks one at a time to create bootable disks.

This creates bootable disks for 32-bit OS/2 Warp 4.5.2.

VMware Tools in a IBM OS/2 Wrap 4.5.2
VMware Tools does not support IBM OS/2 Warp 4.5.2.

IBM OS/2 Warp 4.0

The easiest method of installing IBM OS/2 Warp 4.0 in a virtual machine is to use the standard distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

Create a minimum of 120 MB for OS swap space.

Have both the OS/2 Warp 4.0 boot disk CD and the OS/2 Warp 4.0 install CD available for install.
Additional disks size should be less than or equal to 528MB.

Additional disks have to be of the same type already in use by the virtual machine. For example, if an IBM
OS/2 Warp guest is installed on a BusLogic disk, any additional disks should also be BusLogic disks. The
same is true for LSI Logic and IDE.

Installation Steps

1
2
3
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Insert the first OS/2 Warp 4.0 installer disk in the disk drive.
Make sure Boot from Removable Devices-Legacy Floppy Drives isenabled from the BIOS settings.
Insert the second and third installer disks when requested.

After installing the required drivers from the third disk, insert the OS/2 Warp 4.0 install CD into the CD
drive.

After installing the required drivers from the boot disk CD, insert the OS/2 Warp 4.0 install CD into the
CD drive.

Press the F3 key to use the command line interface to partition the hard drive.
Alternatively, press Enter to select the GUI mode.

Partition the hard disk drive using the FDISK utility. Create an appropriate start volume on which to
install the guest, and save the FDSIK settings.

Re-insert the first OS/2 Warp 4.0 installer disk in the CD drive and reboot the guest.

Re-insert the second and third installer disks during the initial startup.

31



Guest Operating System Installation Guide
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11
12
13
14

After the initial startup completes, insert the OS/2 Warp 4.0 install CD in the CD drive.

The start volume is displayed on the screen.

Select an appropriate volume to install the guest.

Format the file system with File Allocation Table (FAT) File System or High Performance File System (HPFS).
Continue the installation by selecting components, utilities, and other resources.

After completing the installation, reboot the guest.

Create Boot Disks

Create boot disks from the 32-bit OS/2 Warp 4.0 install CD, using the CDINST utility on a running OS/2
Warp 4.0 guest.

To Create Boot Disk

1
2
3
4

Power on a system in which 32-bit OS/2 Warp 4.0 is installed.

Insert the 32-bit OS/2 Warp 4.0 install CD into the CD drive.
Double-click on the CDINST utility that is located in the root directory.
Insert three blank disks, one by one, respectively.

This creates bootable disks for 32-bit OS/2 Warp 4.0.

VMware Tools in a IBM OS/2 Wrap 4.0
VMware Tools does not support IBM OS/2 Warp 4.0.

Mac OS X Server 10.5 and Mac OS X Server 10.6

You can install the Mac OS X Server 10.5 or Mac OS X Server 10.6 in a virtual machine using the installation
media.
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Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

Before creating a virtual machine, obtain the operating system and any necessary product keys for
installation in that virtual machine.

You must have an Apple-labeled computer to install Mac OS X Server in a virtual machine.

Installation Steps

1
2
3

Insert the Mac OS X Server 10.5 or Mac OS X Server 10.6 installation media.
Power on the virtual machine.

Follow the prompts until you are prompted to select the hard disk to install the Mac OS X Server 10.5 or
Mac OS X Server 10.6.

Select the hard disk and follow the prompts to complete the installation.
(Optional) If you do not find a hard disk, select Utilities > Disk Utility.
a  Intheleft hand pane, select VMware Virtual Disk Media.

b Select the Erase tab and confirm that the Format drop-down menu includes the file system type and
Name.

¢ Select Erase and wait for the process to complete.

d  Exit the Disk Utility application.
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e  Select the hard disk that was erased.
f  Click Install and follow the prompts to complete the installation.

Install VMware Tools.

Mandriva Corporate 4

The easiest method of installing Mandriva Corporate 4 Desktop or Server in a virtual machine is to use the
standard Mandriva Linux distribution CD. You can also install Mandriva Corporate 4 with a boot
floppy/network method is supported.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

During the Mandriva Corporate 4 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside
the virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Corporate 4.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

On a Linux host with an XFree86 3.x X server, it is best not to run a screen saver in the guest operating
system. Guest screen savers that demand a lot of processing power can cause the X server on the host to
freeze.

Installation Steps

1
2
3

Insert the Mandriva Corporate 4 CD in the CD-ROM drive.

Power on the virtual machine.

Follow the prompts to complete the installation.

Use the text mode installer.

a At the opening screen, press F1 for options.

b  Enter text for text mode.

When you are prompted to partition, unless you have special requirements, select Use free space.
At the Summary screen, select Graphical Interface, and then click Do to configure the graphical interface.
Make the following selections:

®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

Install VMware Tools.

Mandriva Linux 2009

The easiest method of installing Mandriva Linux 2009 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2009 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:
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Read “General Installation Instructions for All VMware Products” on page 13.
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During the Mandriva Linux 2009 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside
the virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 2009.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandriva Linux 2009 CD in the CD-ROM drive.

Power on the virtual machine.

Follow the prompts to complete the installation.

Use the text mode installer.

a At the opening screen, press F1 for options.

b  Enter text for text mode.

When you are prompted to partition, unless you have special requirements, select Use free space.
At the Summary screen, select Graphical Interface, and then click Do to configure the graphical interface.
Make the following selections:

®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

Install VMware Tools.

Mandriva Linux 2008

The easiest method of installing Mandriva Linux 2008 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2008 via the boot floppy/network method is supported as well.
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Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

During the Mandriva Linux 2008 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside
the virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 2008.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandriva Linux 2008 CD in the CD-ROM drive.
Power on the virtual machine.

Follow the prompts to complete the installation.
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Use the text mode installer.

a At the opening screen, press F1 for options.

b  Enter text for text mode.

When you are prompted to partition, unless you have special requirements, select Use free space.

At the Summary screen, select Graphical Interface, and then click Do to configure the graphical interface.
Make the following selections:

B The resolution and refresh rate you want your guest to use

B VMware virtual video card

B No when asked if you want to install updates to the packages

B No when asked if you want to start X when you reboot

Install VMware Tools.

Mandriva Linux 2007

The easiest method of installing Mandriva Linux 2007 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2007 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2007:

During the Mandriva Linux 2007 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside
the virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 2007.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

VMware, Inc.

Insert the Mandriva Linux 2007 CD in the CD-ROM drive.

Power on the virtual machine.

Follow the prompts to complete the installation.

Use the text mode installer.

a At the opening screen, press F1 for options.

b  Enter text for text mode.

When you are prompted to partition, unless you have special requirements, select Use free space.
At the Summary screen, select Graphical Interface, and then click Do to configure the graphical interface.
Make the following selections:

®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot
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7  Install VMware Tools.

Mandriva Linux 2006

The easiest method of installing Mandriva Linux 2006 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2006 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

B Read “General Installation Instructions for All VMware Products” on page 13.
B Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2006:

B During the Mandriva Linux 2006 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside
the virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 2006.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Mandriva Linux 2006 CD in the CD-ROM drive.
2 Power on the virtual machine.
3 Follow the prompts to complete the installation.
4 Use the text mode installer.
a At the opening screen, press F1 for options.
b  Enter text for text mode.
5  When you are prompted to partition, unless you have special requirements, select Use free space.
6  Atthe Summary screen, select Graphical Interface, and then click Do to configure the graphical interface.
Make the following selections:
®  The resolution and refresh rate you want your guest to use
B VMware virtual video card
®  No when asked if you want to install updates to the packages
®  No when asked if you want to start X when you reboot

7  Install VMware Tools.

Mandrake Linux 10
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The easiest method of installing Mandrake Linux 10 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 10 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

®  Create and configure a new virtual machine.
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Consider these support and configuration issues for Mandrake Linux 10:

B During the Mandrake Linux 10 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the
virtual machine, you should install the VMware Tools package immediately after installing Mandrake
Linux 10.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Mandrake Linux 10 CD in the CD-ROM drive.
2 Power on the virtual machine.
3 Follow the prompts to complete the installation.
4 Use the text mode installer.
a At the opening screen, press F1 for options.
b  Enter text for text mode.
5  When you are prompted to partition, unless you have special requirements, select Use free space.
6  Atthe Summary screen, select Graphical Interface, and then click Do to configure the graphical interface.
Make the following selections:
®  The resolution and refresh rate you want your guest to use
B VMware virtual video card
®  No when asked if you want to install updates to the packages
®  No when asked if you want to start X when you reboot

7  Install VMware Tools.

Mandrake Linux 9.x

The easiest method of installing Mandrake Linux 9.x in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 9.2 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B During the Mandrake Linux 9 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual
machine, you should install the VMware Tools package immediately after installing Mandrake Linux 9.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps for Mandrake Linux 9.2

1  Insert the Mandrake Linux 9.2 CD in the CD-ROM drive.
Power on the virtual machine.

Follow the prompts to complete the installation.

Click in the opening screen and press F1 to install using text mode.

g = W DN

At the command line, type text and press Enter.
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10
11
12
13

In the DrakX Partitioning wizard, select Use free space and select Next.
Unless you have special disk requirements, let Mandrake Linux allocate the space.

When you reach the Package Group Selection screen, select the type of computer on which you installed
your VMware product.

If you installed your VMware product on a laptop computer, make the following selections:
a Click Advanced.

b Select Individual package selection and select Next.

¢ Scroll to numlock and deselect the asterisk and select Next.

If you do not disable numlock when you install the guest on a laptop, the number lock is always
active in the guest. You cannot disable it by pressing the Num Lock key.

At the Summary screen, select Graphical interface and select Do.

Make the following selections for the graphical interface:

B A monitor for the guest

B VMware virtual video card

m  XFree4.3

B The resolution and refresh rate for the guest

B No to not test the configuration

B No to not start X when you reboot

When you complete the graphical interface selections, the Summary screen reappears.
In the Summary screen, select Next.

Select No to not install updates to the packages.

Select Reboot to complete the basic installation of the Mandrake Linux 9.2 guest operating system.

Install VMware Tools.

Installation Steps for Mandrake Linux 9.1 and 9.0

1
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11
12

Insert the Mandrake Linux 9.1 or 9.0 CD in the CD-ROM drive.

Power on the virtual machine to start installing Mandrake Linux 9.1 or 9.0.

Follow the prompts to complete the installation. Be sure to make the choices outlined in the following steps.
Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
Use the Expert installer.

In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
automatically allocate the space. Click Use free space.

VMware GSX Server: When selecting a boot loader, use LILO with text menu. Do not use the graphical
version of LILO. It causes the virtual machine to hang.

Do not create a custom boot disk when prompted.

Near the end of the installation, after files have been copied, you reach the monitor setup screen. Select
the resolution and refresh rate you want your guest to use. Select VMware virtual video card.

You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.1. This driver recognizes the
VMware SVGA driver.

When the installer asks if you want to test the configuration, answer No.

When the installer asks whether to start X when you reboot, answer No.
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When the installer asks if you want to install updates to the packages, answer No.
Install VMware Tools from the Linux console.

As you are installing and configuring VMware Tools, the configuration program asks for the location of
lspci. When that prompt appears, enter the following path: /usr/bin/1spcidrake

Mandrake Linux 8.x

The easiest method of installing Mandrake Linux 8.x in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 8 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

During the Mandrake Linux 8 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run the X server. Instead, to get an accelerated SVGA X server running inside the virtual
machine, you should install the VMware Tools package immediately after installing Mandrake Linux 8.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps for Mandrake Linux 8.2

1
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Insert the Mandrake Linux 8.2 CD in the CD-ROM drive.

Power on the virtual machine.

Use the Expert installer.

When you are prompted to partition, unless you have special requirements, allocate the space.
Select LILO with text menu.

Do not use the graphical version of LILO. It causes the virtual machine to stop responding.
Do not create a custom boot disk when prompted.

You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.0. This driver recognizes the
VMware SVGA driver.

At the monitor setup screen, select the resolution and refresh rate you want your guest to use.
When the installer asks if you want to test the configuration, answer No.

When the installer asks if you want to install system updates, answer No.

When the installer asks whether to start X when you reboot, answer No.

Install VMware Tools.

Installation Steps for Mandrake Linux 8.1 and 8.0

1
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Insert the Mandrake Linux 8.1 or 8.0 CD in the CD-ROM drive.

Power on the virtual machine.

Use the Expert installer.

When you are prompted to partition, unless you have special requirements, allocate the space.
Select LILO with text menu.

Do not use the graphical version of LILO. It causes the virtual machine to stop responding.
On the Select a Graphic Card screen, select Other > Generic VGA compatible.

At the monitor setup screen, select Super VGA, 800x600 @ 56 Hz.

39



Guest Operating System Installation Guide

10

When the installer asks whether to start X when you reboot, answer No.
Install VMware Tools from the Linux console.

As you are installing and configuring VMware Tools, the configuration program asks for the location of
lspci. When that prompt appears, enter the following path: /usr/bin/1spcidrake

Do not start X until you have installed VMware Tools and set up a symbolic link to the XFree86
configuration file.

After installation, consider the following configuration.

Set Up a Symbolic Link to XFree86

To Set Up a Symbolic Link to XFree86

1

Log on as root (su -), and then set up a symbolic link to the correct XFree86 configuration file.

cd /etc
In -s /etc/X11/XF86Config.vm XF86Config

Use the startx command to start your X server.

Novell Linux Desktop 9

The easiest method of installing Novell Linux Desktop 9 in a virtual machine is to use the standard Novell
Linux Desktop distribution CDs. The notes below describe an installation using the standard distribution CD;
however, installing Novell Linux Desktop 9 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Novell Linux Desktop 9 installation CD in the CD-ROM drive.
Power on the virtual machine.

Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to
select text mode and press Enter to select the text mode installer.

During final configuration, after all packages are installed, do not perform the Internet connection test.
Follow the prompts to complete the installation.

Install VMware Tools.

Oracle Enterprise Linux 5 and Oracle Enterprise Linux 6
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The easiest method of installing Oracle Enterprise Linux 5 or Oracle Enterprise Linux 6 in a virtual machine is
to use the standard distribution CD. The notes below describe an installation using the standard distribution
CD; however, installing Oracle Enterprise Linux 5 or Oracle Enterprise Linux 6 via the boot floppy/network
method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

For ESX 4.0 and earlier, depending on the guest operating system you are installing, select Red Hat
Enterprise Linux 5 32-bit, Red Hat Enterprise Linux 5 64-bit, Red Hat Enterprise Linux 6 32-bit, or Red Hat
Enterprise Linux 6 64-bit. Oracle Enterprise Linux 5 and Oracle Enterprise Linux 6 are not listed as
options.

VMware, Inc.



Installing Guest Operating Systems

When creating the virtual machine, select the LSI Logic SCSI adapter. Oracle Enterprise Linux 5 does not
include a driver for the BusLogic SCSI adapter.

Configure the virtual machine with at least 512MB of memory for 32-bit and 1GB of memory for 64-bit. If
the virtual machine has less than 512MB of memory, Oracle Enterprise Linux 5 or Oracle Enterprise
Linux 6 display an error message when loading certain VMware drivers.

Installation Steps

1
2
3

Insert the Oracle Enterprise Linux 5 or Oracle Enterprise Linux 6 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Oracle Enterprise Linux 5 or Oracle Enterprise Linux 6.
Follow the prompts to complete the installation.

Do not select Virtualization Option during the installation

Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.

In the Automatic Partitioning screen, allow automatic partitioning.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. The virtual hard drive in your virtual machine needs to be partitioned and formatted.

Click Yes to partition the drive.
Start Oracle Enterprise Linux 6 using non-UEK (Unbreakable Enterprise Kernel).

Install VMware Tools.

VMware Tools in an Oracle Enterprise Linux 5 and Oracle Enterprise Linux 6

Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Oracle Enterprise Linux 4

The easiest method of installing Oracle Enterprise Linux 4 in a virtual machine is to use the standard

distribution CD. The notes below describe an installation using the standard distribution CD. Installing Oracle

Enterprise Linux 4 by the boot floppy/network method is also supported.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

For ESX, select Red Hat Enterprise Linux 4 32-bit or Red Hat Enterprise Linux 4 64-bit for the guest
operating system. Oracle Enterprise Linux 4 is not listed as an option.

When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Oracle Enterprise Linux
4 does not include a driver for the BusLogic SCSI adapter.

Configure the virtual machine with at least 512MB of memory. If the virtual machine has less than 512MB
of memory, Oracle Enterprise Linux 4 presents an error message as it loads certain VMware drivers.

Installation Steps

1
2
3
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Insert the Oracle Enterprise Linux 4 CD-ROM in the CD-ROM drive.
Power on the virtual machine.

Follow the prompts to complete the installation. Be sure to make the choices outlined in the following
steps.

Do not select Virtualization Option during the installation.

Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.

41


http://kb.vmware.com/kb/9134325
http://kb.vmware.com/kb/9134325

Guest Operating System Installation Guide

In the Automatic Partitioning screen, allow automatic partitioning.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

Click Yes to partition the drive.

Install VMware Tools.

VMware Tools in an Oracle Enterprise Linux 4 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Red Hat Enterprise Linux 6

This section contains product support, installation instructions, and known issues for the Red Hat Enterprise
Linux 6 operating system.

The easiest method of installing Red Hat Enterprise Linux 6 in a virtual machine is to use the standard RedHat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 6 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Configure the virtual machine with at least 1GB of memory.

When creating the virtual machine, select the LSI Logic SCSI adapter. Red Hat Enterprise Linux 6 does not
include a driver for the BusLogic SCSI adapter, so do not attempt to use this HBA.

See knowledge base article 1033654 at http://kb.vmware.com/kb/1033654 for more information on
network connection failure after rebooting Red Hat Enterprise Linux 6.

Installation Steps

1
2
3

Insert the Red Hat Enterprise Linux 6 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Enterprise Linux 6.
Follow the prompts to complete the installation.

In Storage Devices screen, reinitialize the virtual machine.

You can safely ignore the following warning message “This device may need to be reinitialized.
REINITIALIZING WILL CAUSE ALL DATA TO BE LOST!”This does not mean that anything is wrong
with the hard drive on your physical computer. The virtual hard drive in your virtual machine needs to
be reinitialized.

Click Re-initialize all to continue.

Install VMware Tools.

VMware Tools in a Red Hat Enterprise Linux 6 Guest

VMware Tools operations are disabled on Red Hat Enterprise Linux 6 when you enable SELinux policy. See
knowledge base article 1033693 at http://kb.vmware.com/kb/1033693 for more information.

Red Hat Enterprise Linux 5

This section contains product support, installation instructions, and known issues for the Red Hat Enterprise
Linux 5 operating system.
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The easiest method of installing Red Hat Enterprise Linux 5 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 5 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

Configure the virtual machine with at least 512MB of memory. If the virtual machine has less than 512MB
of memory, Red Hat Enterprise Linux 5 presents an error message as it loads certain VMware drivers.

When creating the virtual machine, select the LSI Logic SCSI adapter. Red Hat Enterprise Linux 5 does not
include a driver for the BusLogic SCSI adapter.

Installation Steps

1
2
3

Insert the Red Hat Enterprise Linux 5 CD-ROM in the CD-ROM drive.

Power on the virtual machine to start installing Red Hat Enterprise Linux 5.

Follow the prompts to complete the installation.

Do not select Virtualization Option during the installation.

Refer to knowledge base article 9134325 at http://kb.vmware.com/kb/9134325 for more information.
In the Automatic Partitioning screen, allow automatic partitioning.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. The virtual hard drive in your virtual machine needs to be partitioned and formatted.

Click Yes to partition the drive.

Install VMware Tools.

VMware Tools in a Red Hat Enterprise Linux 5 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Red Hat Enterprise Linux 4

The easiest method of installing Red Hat Enterprise Linux 4 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 4 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

VMware, Inc.

Read “General Installation Instructions for All VMware Products” on page 13.

VMware Workstation, VMware ACE, VMware GSX Server. When creating the virtual machine, select
the LSI Logic SCSI adapter. Red Hat Enterprise Linux 4 does not include a driver for the BusLogic SCSI
adapter.

Configure the virtual machine with at least 256MB of memory. If the virtual machine has less than 256MB
of memory, Red Hat Enterprise Linux presents an error message as it loads certain VMware drivers.

The Red Hat Enterprise Linux 4 hugemem kernel is not supported. See knowledge base article 8964517 at
http://kb.vmware.com/kb/8964517.

See knowledge base article 1018631 at http://kb.vmware.com/kb/1018631 for information about a kernel
panic error that occurs when you install Red Hat Enterprise Linux 4.0, 4.1, or 4.2 on an AMD NPT
processor.

SCSI adapter support
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B Red Hat Enterprise Linux 4, Update 1, 2, 3, 4, and 5: ESX Server 2.5.2, 2.5.3, 2.5.4, and 2.5.5 support
only the BusLogic SCSI adapter on Red Hat Enterprise Linux 4, Update 1, 2, 3, 4, and 5.

B Red Hat Enterprise Linux 4, Update 6 and Update 7: ESX Server 2.5.2, 2.5.3, 2.5.4, and 2.5.5 support
both the LSI Logic and BusLogic SCSI adapter on Red Hat Enterprise Linux 4, Update 6 and Update 7.

B VMware provides a separate driver to support the BusLogic SCSI adapter. For instructions on
downloading and installing the BusLogic driver, see
www.vmware.com/download/esx/drivers_tools.html.

Installation Steps

1
2
3

7

Insert the Red Hat Enterprise Linux 4 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Enterprise Linux 4.

Follow the prompts to complete the installation. Be sure to make the choices outlined in the following
steps.

VMware GSX Server: In the Package Group Selection screen, choose Software Development and select
individual packages. In the Individual Package Selection screen, use the arrow keys to move down to
System Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should
appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do
not need to change any other selections.

In the Automatic Partitioning screen, allow automatic partitioning.

You might see a warning that begins “The partition table on device <devicename> was unreadable.
To create new partitions it must be initialized, causing the loss of ALL DATA on the
drive.” This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

Click Yes to partition the drive.

B VMware GSX Server: If your computer is connected to a LAN that provides DHCP support, in the
Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also
set the networking parameters manually.

B VMware ESX Server: If you are using the vlance network adapter in your virtual machine and your
computer is connected to a LAN that provides DHCP support, in the Network Configuration screen,
you can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters
manually. If you are using the vimxnet network adapter in your virtual machine, use the network
configuration tools in Red Hat Enterprise Linux 4 to configure your network connection after you
finish installing the guest operating system.

Install VMware Tools.

VMware Tools in a Red Hat Enterprise Linux 4 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Red Hat Enterprise Linux 3
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The easiest method of installing Red Hat Enterprise Linux 3 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 3 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

The Red Hat Enterprise Linux 3 hugemem kernel is not supported. See knowledge base article 8964517 at
http://kb.vmware.com/kb/8964517.
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Configure the virtual machine with at least 256MB of memory. If the virtual machine has less than 256MB
of memory, Red Hat Enterprise Linux presents an error message as it loads certain VMware drivers.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
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Insert the Red Hat Enterprise Linux 3 CD-ROM in the CD-ROM drive.

Power on the virtual machine.

At the boot prompt, type text and press Enter.

Follow the prompts to complete the installation.

Select the language and keyboard.

In the Installation Type screen, choose either Advanced Server or Custom for the installation type.
In the Mouse Selection screen, choose one of the following options.

B Generic - 3 Button Mouse (PS/2) and select the Emulate 3 Buttons option for three-button mouse
support in the virtual machine.

®  If you have a wheel mouse, you can choose Generic Wheel Mouse (PS/2).

VMware GSX Server only: In the Package Group Selection screen, choose Software Development and
Select individual packages. In the Individual Package Selection screen, use the arrow keys to move down
to System Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should
appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do
not need to change any other selections.

In the Automatic Partitioning screen, allow automatic partitioning.
You might see a warning that says:

The partition table on device sda was unreadable. To create new partitions, it must be
initialized, causing the loss of ALL DATA on the drive.
Would you like to initialize this drive?

This does not mean that anything is wrong with the hard drive on your physical computer. The virtual
hard drive in your virtual machine needs to be partitioned and formatted.

Select the Yes button and press Enter. sda appears in the message as the device name if the virtual disk in
question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device name
instead.

Configure the network connection.

B VMware GSX Server. If your computer is connected to a LAN that provides DHCP support, in the
Network Configuration screen, you can select the option Use bootp/dhcp.

B VMware ESX Server, VMware VirtualCenter, or vCenter Server. If you are using the vlance network
adapter in your virtual machine and your computer is connected to a LAN that provides DHCP
support, in the Network Configuration screen, you can select the option Use bootp/dhcp. If you are
using the vmxnet network adapter in your virtual machine, use the network configuration tools in
Red Hat Enterprise Linux 3 to configure your network connection after you finish installing the guest
operating system.

Install VMware Tools.

VMware Tools in a Red Hat Enterprise Linux 3 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

VMware, Inc.
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Red Hat Enterprise Linux 2.1
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The easiest method of installing Red Hat Enterprise Linux 2.1 in a virtual machine is to use the standard
Red Hat distribution CD. The notes below describe an installation using the standard distribution CD;
however, installing Red Hat Enterprise Linux 2.1 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B Red Hat Enterprise Linux 2.1 WS on VMware ESX Server. Use Update 6 or higher to eliminate conflicts
with the network and SCSI adapters and installation problems on a Red Hat Enterprise Linux 2.1 WS
guest operating system.

®  Ifyou donot install Update 6 or higher, use one of the following configurations for the network and SCSI
adapters:

B vlance network adapter —Use an LSI Logic SCSI adapter.
B vmxnet network adapter —Use an LSI Logic SCSI adapter or BusLogic adapter.

B Do not run the X server that is installed when you set up Red Hat Enterprise Linux 2.1. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Enterprise Linux 2.1.

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

®  For additional information on using uniprocessor and multiprocessor kernels with a Red Hat Enterprise
Linux 2.1 virtual machine under VMware ESX Server, see the release notes at
www.vmware.com/support/esx21/doc/releasenotes_esx213.html.

Installation Steps

1  Insert the Red Hat Enterprise Linux 2.1 CD-ROM in the CD-ROM drive.
Power on the virtual machine.

At the boot prompt, type text and press Enter.

Follow the prompts to complete the installation.

Select the language and keyboard.

In the Installation Type screen, choose either Advanced Server or Custom for the installation type.
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In the Mouse Selection screen, choose one of the following options.

B Generic — 3 Button Mouse (PS/2) and select the Emulate 3 Buttons option for three-button mouse
support in the virtual machine.

®  If you have a wheel mouse, you can choose Generic Wheel Mouse (PS/2).

8 VMware GSX Server only. In the Package Group Selection screen, choose Software Development and
Select individual packages. In the Individual Package Selection screen, use the arrow keys to navigate to
System Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should
appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do
not need to change any other selections.

VMware ESX Server, VirtualCenter, or vCenter Server if installing to an ESX Server machine without
virtual SMP. In the Individual Package Selection screen, use the arrow keys to navigate to System
Environment/Kernel and press Enter. Be sure that the following kernels are deselected (no asterisk
should appear between the brackets):

B Kernel-enterprise

B Kkernel-smp

VMware, Inc.
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B kernel-summit

VMware ESX Server, VirtualCenter, or vCenter Server if installing to an ESX Server machine with
virtual SMP. In the Individual Package Selection screen, use the arrow keys to navigate to System
Environment/Kernel and press Enter.

B If you are installing a multiprocessor virtual machine, be sure kernel-smp is selected.

®m  If you are installing a uniprocessor virtual machine, be sure the following kernels are deselected:
kernel-enterprise, kernel-smp and kernel-summit.

In the Automatic Partitioning screen, allow automatic partitioning.
You might see a warning that says:

The partition table on device sda was unreadable. To create new partitions, it must be
initialized, causing the loss of ALL DATA on the drive.
Would you like to initialize this drive?

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted.

Select the Yes button and press Enter.

sda appears in the message as the device name if the virtual disk is a SCSI disk. If the virtual disk is an
IDE drive, hda appears in the message as the device name instead.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, select the option Use bootp/dhcp.

In the Video Card Configuration screen, choose Generic SVGA.

Install VMware Tools.

VMware Tools in a Red Hat Enterprise Linux 2.1 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Red Hat Linux 9.0

The easiest method of installing Red Hat Linux 9.0 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 9.0 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

You should not run the X server that is installed when you set up Red Hat Linux 9.0. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 9.0.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3
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Insert the Red Hat Linux 9.0 CD-ROM in the CD-ROM drive.
Power on the virtual machine.

At the boot prompt, type 1inux text and press Enter.

IMPORTANT If you attempt to use the graphical installer, it fails and launches the text mode installer.

Follow the prompts to complete the installation.
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5  Choose the language and keyboard.
6  In the Mouse Selection screen, choose one of the following options.

B Generic - 3 Button Mouse (PS/2) and select the Emulate 3 Buttons option for three-button mouse
support in the virtual machine.

®  If you have a wheel mouse, you can choose Generic Wheel Mouse (PS/2).
7 In the Installation Type screen, select the installation type.
8  Inthe Automatic Partitioning screen, allow automatic partitioning.

You might see a warning that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. The virtual
hard drive in your virtual machine needs to be partitioned and formatted.

9  Select the Initialize button and press Enter.

sda appears in the message as the device name if the virtual disk is a SCSI disk. If the virtual disk is an
IDE drive, hda appears in the message as the device name.

10 If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, select Use bootp/dhcp.

11 In the Video Card Configuration screen, choose Skip X Configuration.

12 Install VMware Tools.

VMware Tools in a Red Hat Linux 9.0 Guest
Do not start the X server in the guest operating system until you install VMware Tools.

When you are installing VMware Tools, the configuration program asks you to specify a resolution for the
guest operating system’s display. Set the resolution to 1152 x 864 or lower. If you set a higher resolution, the
guest operating system instead switches to a default resolution of 800 x 600.

Red Hat Linux 8.0

The easiest method of installing Red Hat Linux 8.0 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 8.0 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B Do not run the X server that is installed when you set up Red Hat Linux 8.0. Instead, to get an accelerated
SVGA X server running inside the virtual machine, you should install the VMware Tools package
immediately after installing Red Hat Linux 8.0.

B With many Linux guest operating systems, problems have been observed when the BusLogic virtual SCSI
adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual
SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Red Hat Linux 8.0 CD-ROM in the CD-ROM drive.
2 Power on the virtual machine.

3 At the boot prompt, type Linux text and press Enter.

IMPORTANT If you attempt to use the graphical installer, it fails and launches the text mode installer.
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Follow the prompts to complete the installation.

Choose the language and keyboard.

In the Installation Type screen, choose either Server or Workstation.
In the Mouse Selection screen, choose one of the following options.

B Generic — 3 Button Mouse (PS/2) and select the Emulate 3 Buttons option for three-button mouse
support in the virtual machine.

®  If you have a wheel mouse, you can choose Generic Wheel Mouse (PS/2).
You might see a warning that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. The virtual
hard drive in your virtual machine needs to be partitioned and formatted.

Select the Initialize button and press Enter.

sda appears in the message as the device name if the virtual disk is a SCSI disk. If the virtual disk is an
IDE drive, hda appears in the message as the device name.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, select Use bootp/dhcp.

10 In the Video Card Configuration screen, choose Skip X Configuration.

11

Install VMware Tools.

VMware Tools in a Red Hat Linux 8.0 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Red Hat Linux 7

Install Red Hat Linux 7 in a virtual machine using the standard Red Hat distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

Do not run the X server that is installed when you set up Red Hat Linux 7. Instead, to get an accelerated
SVGA X server running inside the virtual machine, you should install the VMware Tools package
immediately after installing Red Hat Linux 7.

With many Linux guest operating systems, problems have been observed when the BusLogic virtual SCSI
adapter is used with VMware virtual machines. VMware recommends that you use the LSI Logic virtual
SCSI adapter with this guest operating system.

Installation Steps

1
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Insert the Red Hat Linux 7 CD-ROM in the CD-ROM drive.

Power on the virtual machine.

At the boot prompt, type text followed and press Enter.

Follow the prompts to complete the installation.

Choose the language and keyboard.

In the Installation Type screen, choose either Server or Workstation.

The following warning might appear:
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Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. The virtual
hard drive in your virtual machine needs to be partitioned and formatted.

Click the Initialize button and press Enter.

sda appears in the message as the device name if the virtual disk in question is a SCSI disk. If the virtual
disk is an IDE drive, hda appears in the message as the device name.

In the Automatic Partitioning screen, select automatic partitioning.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp.

In the Mouse Selection screen, select Generic — 3 Button Mouse (PS/2).

Select the Emulate 3 Buttons option for three-button mouse support in the virtual machine.
In the Video Card Selection screen, select the default selection.

During the configuration of the X server, select the defaults. T

This X server is replaced by an X server specific to your guest operating system when you install VMware
Tools in this virtual machine.

Continue to the Starting X screen and click Skip.

Install VMware Tools.

VMware Tools in a Red Hat Linux 7 Guest

Do not start X until you have installed VMware Tools.

Red Hat Linux 6.2

The easiest method of installing Red Hat Linux 6.2 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 6.2 via the boot floppy/network method is supported as well.
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Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

During the Red Hat Linux 6.x installation, a standard VGA16 X server (without support for the VMware
X server) is installed. To run an accelerated SVGA X server inside the virtual machine, install the VMware

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

NOTE Red Hat Linux 6.2 runs on Intel core processors. However, it does not run on Xeon processors that are
branded Xeon, with no qualifier, or Xeon-MP. Pentium III Xeon processors are OK.

Installation Steps

1
2
3

Insert the Red Hat Linux 6.2 installation CD in the CD-ROM drive.
Power on the virtual machine.

At the Red Hat 6.2 CD boot prompt, type text and press Enter.
Follow the prompts to complete the installation.

If the virtual machine’s Ethernet adapter has been enabled, the installation program detects and loads the
AMD PC/Net 32 driver (no command-line parameter is necessary to load the driver).

VMware, Inc.
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5 If you are installing this guest with DHCP in a virtual machine with host-only networking, do not specify
a host name. Click OK and continue. At the Network Configuration screen, click OK to use the default.

Select the standard VGA16 X server.
In the Choose a Card screen, select Generic VGA compatible/Generic VGA.

In the Monitor Setup screen, select Generic Monitor.
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Click Probe in the Screen Configuration dialog box.
10 Click OK from the Starting X dialog box.

After Linux is installed, the generic X server is replaced with the accelerated X server included in the
VMware Tools package when you install VMware Tools.

11 Follow the prompts to complete the installation.
Red Hat 6.2 boots and a login screen appears.

12 Install VMware Tools.

Sun Java Desktop System 2

The easiest method of installing Sun Java Desktop System 2 in a virtual machine is to use the standard Sun
Java Desktop System distribution CDs. The notes below describe an installation using the standard
distribution CD; however, installing Sun Java Desktop System 2 via the boot floppy/network method is
supported as well.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B Create and configure a new virtual machine.

Installation Steps

1  Insert the Sun Java Desktop System 2 installation CD in the CD-ROM drive.
2 Power on the virtual machine.

3 Follow the prompts to complete the installation.

4 Install VMware Tools.

SCO OpenServer 5.0

You can install SCO OpenServer 5.0 in a virtual machine using the standard distribution CDs, using the boot
floppy/network method, and if your VMware product supports it, you can also install from a PXE server.

Before you begin, verify that the following tasks are complete:

B Read “General Installation Instructions for All VMware Products” on page 13.

Virtual disk recommendations

B Minimum size — 1.5GiB for the SCO OpenServer 5.0 root disk.

B biosgeombootstring — Required for SCSI drives between 1 and 64GiB. (Not harmful to other drive sizes.).
®  IDE virtual disks — SCO BTLD (wd boot-time loadable driver) for improved performance and reliability.
B Special considerations for drive sizes:

®  OpenServer 5.0.7 — wd BTLD is required for IDE disks larger than 128GiB (137GB).

B OpenServer 5.0.6 — Cannot use IDE disks that are 128 GB or larger.
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Supported virtual disks

BusLogic SCSI — Requires SCO blc BTLD 3.05.1 or later.
LSI SCSI - Requires SCO Isil BTLD 1.03.28 or later.

LSI SAS — Requires LSI Logic Isil BTLD 1.04.09 or later.
IDE

Under 128GiB — no BTLD required.

128GiB or more — 5.0.7 only, requires SCO “wd” BTLD.

Supported drivers

Suitable NIC and HBA drivers are not included in the base SCO OpenServer 5.0 distributions. You can
download from the Internet.

SCO Intel PRO/1000 network adapter driver (Search for the eeG driver.)
ftp://ftp.sco.com/pub/openserver5/drivers/

SCO IDE BTLD, located on the SCO FTP Web site:
ftp://ftp.sco.com/pub/openserver5/507/drivers/wd_3.0/

SCO BusLogic BTLD 3.05.1, located on the SCO FTP Web site:
ftp://ftp.sco.com/pub/openserver5/507/drivers/blc_3.05.1/

SCO LSI Logic BTLD 1.03.28, located on the SCO FTP Web site:
ftp://ftp.sco.com/pub/openserver5/507/drivers/lsil_1.03.28/

LSI Logic LSISAS BTLD 1.04.09, located on the LSI Logic Web site:

http://www.lsi.com/DistributionSystem/AssetDocument/files/support/ssp/fusionmpt/SCO/SCO_op5_m
pt_Isil_10409.zip

http://www.lsi.com/DistributionSystem/AssetDocument/files/support/ssp/fusionmpt/sas/linux/scounix_
10409.txt

NOTE Floppy images must be renamed with a .f1p extension to be accepted by ESX. The location of the floppy
images on the LSI Web site do not appear to be static. If you cannot locate the floppy images at the addresses
VMware provided, try contacting an LSI representative

Installation Steps

1
2
3
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Insert the SCO-OSR506-InstallCD for 5.0.6, or SCO-OSR507-InstallCD for 5.0.7, in the CD-ROM drive.
Power on the virtual machine.
Install the appropriate SCSI drivers:
®  IDE disk under 128GiB (137GB)
No boot string required, press Enter.
m  ]DE disk 128GiB (137GB) or larger (5.0.7 only)
restart link="wd”
When prompted to replace the driver, type r.
®  Buslogic
restart link="blc" biosgeom
When prompted to replace the driver, type r.
m  LSILogic SCSI or SAS

VMware, Inc.


ftp://ftp.sco.com/pub/openserver5/drivers/
ftp://ftp.sco.com/pub/openserver5/drivers/
ftp://ftp.sco.com/pub/openserver5/507/drivers/wd_3.0/
ftp://ftp.sco.com/pub/openserver5/507/drivers/blc_3.05.1/
ftp://ftp.sco.com/pub/openserver5/507/drivers/lsil_1.03.28/
http://www.lsi.com/DistributionSystem/AssetDocument/files/support/ssp/fusionmpt/SCO/SCO_op5_mpt_lsil_10409.zip
http://www.lsi.com/DistributionSystem/AssetDocument/files/support/ssp/fusionmpt/sas/linux/scounix_10409.txt

9
10

Installing Guest Operating Systems

restart link="1sil" biosgeom
Insert the appropriate installation disks when prompted.
Read and accept the license agreement.
Accept the default CD-ROM type and controller and drive configuration.
The Open Server 5.0 install checks for the drive type and defaults to the configuration.
Follow the prompts to complete the installation.
Turn off the bad block scan, which is on by default for IDE disks.
The bad block scan is not necessary on a virtual disk.
When selecting the mouse, press h to specify High Resolution Keyboard Mouse.

Follow the prompts to complete the installation.

Install Maintenance Pack 5

After installing Open Server 5.0.7, install Maintenance Pack 5 (MP5).

To Install Maintenance Pack 5

1
2

Power on the OpenServer 5.0.7 guest.

(Optional) If you used biosgeom during the install, boot the guest with the defbootstr biosgeom
command.

Insert the SCO-OSR507-SuppCD5 CD in the CD-ROM drive.

Install MP5 using the Software Manager.

NOTE After MP5 is installed, the virtual machine boots normally without requiring biosgeom.

VMware Tools in a SCO OpenServer 5.0 Guest

VMware Tools does not support SCO OpenServer 5.0.

SCO UnixWare 7

You can install SCO UnixWare 7 in a virtual machine using the standard distribution CDs, via the boot
floppy/network method, and if your VMware product supports it, you can also install from a PXE server.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

SCO UnixWare 7 runs very slowly without assistance from CPU virtualization hardware. For near-native
performance, the host must have support for nested page tables. This is found in AMD Barcelona and later
CPUs with Rapid Virtualization Indexing (RVI) and in Intel Nehalem and later CPUs with Extended Page
Tables (EPT).

Installation Steps

1
2
3
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Insert the SCO UnixWare 7.1.1 or 7.1.4 boot CD in the CD-ROM drive.

Power on the virtual machine.

(Optional) If you selected LSILOGIC/ LSISAS for SCSI adapter, then select Install HBA disk.
Insert the HBA disk.
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Installing SCO UnixWare Maintenance Packs

After installing the guest operating system, install UnixWare 7.1.1 Maintenance Pack 5 (MP5) or UnixWare
7.1.4 Maintenance Pack 4 (MP4) and patch p535283, according to SCO instructions.

The Maintenance Packs are located here:
m  UnixWare 7.1.1 MP5 - ftp: //ftp.sco.com/pub/unixware7/uw711pk
B UnixWare 7.1.4 MP4 - ftp://ftp.sco.com/pub/unixware7/714/mp/uw714mp4/

If you use more than one virtual CPU in this guest, install the OS Multiprocessor Support (OSMP) package,
which is not automatically installed. An additional SCO CPU license is required for each additional CPU.
For example, if you use four virtual CPUs, you need one operating system license and three CPU licenses.

Installing and Configuring SMP

Install OSMP and any necessary licenses according to SCO documentation.

VMware Tools in an SCO UnixWare 7 Guest

VMware Tools does not support SCO UnixWare.

SUSE Linux Enterprise 11

The easiest method of installing SUSE Linux Enterprise 11 Desktop or Server in a virtual machine is to use the
standard SUSE distribution CDs.

Before you begin, verify that the following tasks are complete:

B Read “General Installation Instructions for All VMware Products” on page 13.

B VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.
Installation Steps

1 Insert the SUSE Linux Enterprise 11 installation CD in the CD-ROM drive.

2 Power on the virtual machine.

3 Follow the prompts to complete the installation.

4  Install VMware Tools.

SUSE Linux Enterprise 10
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The easiest method of installing SUSE Linux Enterprise 10 Desktop or Server in a virtual machine is to use the
standard SUSE distribution CDs.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system

Installation Steps

1  Insert the SUSE Linux Enterprise 10 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux Enterprise 10.
3 In the first installation screen, use the arrow keys to select Installation.

4  For the Desktop, press the F2 key, use the arrow keys to choose text mode, and press Enter to select the
text mode installer.

5  For the Server, enter the boot option textmode=1, and press Enter to select the text mode installer.
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At the Installation Settings screen, go to the Change menu and choose Booting.

The Boot Loader Setup screen appears.

Select the boot loader type.

®  For the Desktop edition, set the Boot Loader Type to LILO instead of the default GRUB.
m  For the Server edition, set the Boot Loader Type to the default GRUB.

The installer displays a warning that indicates you might lose some settings and prompts you to select a
course of action.

Select Convert current configuration and continue.
Select Finish to return to the Installation Settings screen.
Follow the prompts to complete the installation.

Install VMware Tools.

SUSE Linux Enterprise Server 9

The easiest method of installing SUSE Linux Enterprise Server 9 in a virtual machine is to use the standard
distribution CDs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

For support for OES 1 on SUSE Linux Enterprise Server 9, select SUSE Linux Enterprise Server 9 from the
Guest Operating System version list.

Only the LSI Logic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 9 virtual machine
with more than 4GB of memory on ESX Server 3.x and 4.x.

Installation Steps

1
2
3

Insert the SLES 9 installation CD in the CD-ROM drive.
Power on the virtual machine.

In the first installation screen, use the arrow keys to select Installation, enter the boot option textmode=1
and press Enter to select the text mode installer.

At the Installation Settings screen, go to the Change menu and select Booting.
The Boot Loader Setup screen appears.
Set the Boot Loader Type to GRUB.

The installer displays a warning that indicates that you might lose some settings and prompts you to select
a course of action. Select Convert current configuration and continue.

Select Finish to return to the Installation Settings screen.
Follow the prompts to complete the installation.

Install VMware Tools.

SUSE Linux Enterprise Server 8

The easiest method of installing SUSE Linux Enterprise Server 8 in a virtual machine is to use the standard
SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux Enterprise Server 8 via the boot floppy/network method is supported as well.

Before you begin, verify that the following tasks are complete:

VMware, Inc.

Read “General Installation Instructions for All VMware Products” on page 13.
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Only the BusLogic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 8 virtual machine
on ESX Server 2.5.x. The LSI Logic virtual SCSI adapter is supported for SUSE Linux Enterprise Server 8
virtual machines on ESX Server 3.x. and 4.x. Only the LSI Logic virtual SCSI adapter is supported in a
SUSE Linux Enterprise Server 9 virtual machine with more than 4GB of memory on ESX Server 3.x

and 4.x.

Installation Steps

1
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Insert the SLES 8 installation CD in the CD-ROM drive.

Power on the virtual machine.

Follow the prompts to continue with the installation.

At the LILO screen, let the boot proceed using the default selection of linux.
At the Desktop Settings screen, select 640x480 256 colors.

Follow the prompts to complete the installation.

Install VMware Tools.

SUSE Linux Enterprise Server 7

The easiest method of installing SUSE Linux Enterprise Server 7 (SLES 7) in a virtual machine is to use the
standard SUSE distribution CDs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

During the SUSE Linux Enterprise Server 7 installation, a standard VGA16 X server should be installed.
To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools
package immediately after installing SUSE Linux Enterprise Server 7.

Installation Steps

1
2
3

Insert the SLES 7 installation CD in the CD-ROM drive.
Power on the virtual machine.
Follow the prompts until you get to the selection screens described in the next steps.

Part way through the installation, the installer reboots the virtual machine. At the LILO screen, let the boot
proceed using the default selection of linux.

At the Desktop Settings screen, select 640x480 256 colors.
Follow the prompts to complete the installation.

Install VMware Tools.

openSUSE Linux 11.x

The easiest method of installing openSUSE Linux 11.x in a virtual machine is to use the standard openSUSE
Linux distribution CDs.
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Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.
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Installing Guest Operating Systems

Installation Steps

1
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Insert the openSUSE Linux 11.x installation CD in the CD-ROM drive.

Power on the virtual machine.

In the first installation screen, press F3 to get boot options.

Press F3 again and use the arrow keys to select text mode and press Enter to select the text mode installer.
At the Installation Settings screen, select Change.

Select Software.

From the Filter menu, select RPM Groups.

Select the Development group and press Enter to open it.

Add gcc, gee-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.

At the Test Internet Connection screen, during final configuration and after all packages are installed, do
not perform the Internet connection test.

Follow the prompts to complete the installation.

Install VMware Tools.

VMware Tools in an openSUSE Linux 11.x Guest

To uninstall open-vm-tools provided by the openSUSE 11.x distribution, see knowledge base article
http://kb.vmware.com/kb/1013096.

openSUSE Linux 10.x

The easiest method of installing openSUSE Linux 10.x in a virtual machine is to use the standard SUSE Linux
distribution CDs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
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Insert the openSUSE Linux 10 installation CD in the CD-ROM drive.

Power on the virtual machine.

In the first installation screen, press F3 to get boot options.

Press F3 again and use the arrow keys to select text mode and press Enter to select the text mode installer.
At the Installation Settings screen, select Change and choose Software.

From the Filter menu, select RPM Groups.

Select the Development group and press Enter to open it.

Add gcc, gee-c++, and kernel-source by highlighting those items in the list and pressing the spacebar.

At the Test Internet Connection screen, during final configuration and after all packages are installed, do
not perform the Internet connection test.

Follow the prompts to complete the installation.

Install VMware Tools.
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SUSE Linux10.x

The easiest method of installing SUSE Linux 10.x in a virtual machine is to use the standard SUSE Linux
distribution CDs.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1  Insert the SUSE Linux 10.x installation CD in the CD-ROM drive.

Power on the virtual machine.

On the text mode installer first installation screen, press F3 for boot options.

Press F3 again and use the arrow keys to select text mode and press Enter to select the text mode installer.
At the Installation Settings screen, select Change, and then select Software.

From the Filter menu, select RPM Groups.
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Select the Development group, press Enter to open it, and add gcc, gcc-c++, and kernel-source by
highlighting those items in the list and pressing the spacebar.

8 At the Test Internet Connection screen during final configuration after all packages are installed do not
perform the Internet connection test.

9  Follow the prompts to complete the installation.

10 Install VMware Tools.

SUSE Linux 9.x
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The easiest method of installing SUSE Linux 9.x in a virtual machine is to use the standard SUSE Linux
distribution CDs.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B Only the BusLogic virtual SCSI adapter is supported in a SUSE Linux 9.x virtual machine on ESX Server 2.5.x.

Installation Steps
1  Insert the SUSE Linux 9.x installation CD in the CD-ROM drive.
2 Power on the virtual machine.
3 Install using the text mode installer.
a  In the first installation screen, select Installation and press F2.
b  Use the arrow keys to select Text Mode and press Enter to select the text mode installer.

4  During final configuration for SUSE Linux 9.3, after all packages are installed, do not perform the Internet
connection test.

5 Follow the prompts to complete the installation.

6  Install VMware Tools.

VMware, Inc.
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After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2
configuration utility to configure your X server.

Run SaX2 Configuration Utility

To Run SaX2 Configuration Utility
1  Atacommand prompt, type SaX2.
2 Follow the prompts in the wizard to configure your X server.

3 If youintend to connect to this virtual machine with the VMware Virtual Machine Console, configure the
color resolution for 65536 (16-bit) colors or less.

4 After you run the SaX2 utility, boot the SUSE Linux 9.x virtual machine with any of the selections offered
in GRUB.

SUSE Linux 8.x

The easiest method of installing SUSE Linux 8.x in a virtual machine is to use the standard SUSE distribution
CDs.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. Use the LSI Logic virtual SCSI adapter with
this guest operating system.

B During the SUSE Linux 8.x installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing SUSE
Linux 8.x.

Installation Steps
1  Insert the SUSE Linux 8.x installation CD in the CD-ROM drive.
2 Power on the virtual machine.
3 Follow the prompts to complete the installation.
4  Install using the text mode installer.
a  In the first installation screen, select Installation and press F2.

b Select Text Mode and press Enter to select the text mode installer.

5  When prompted, do not install an X server.
6  In the Configure Monitor screen, select Text Mode Only.
7  Click Accept.

Install VMware Tools.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2
configuration utility to configure your X server.

Run SaX2 Configuration Utility

To Run SaX2 Configuration Utility
1 Atacommand prompt, type SaX2.

2 Follow the prompts in the wizard to configure your X server.
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If you intend to connect to this virtual machine with the VMware Virtual Machine Console, configure the
color resolution for 65536 (16-bit) colors or less.

After you run the SaX2 utility, boot the SUSE Linux 8.x virtual machine with any of the selections offered
in GRUB.

SUSE Linux 7.3

The easiest method of installing SUSE Linux 7.3 in a virtual machine is to use the standard SUSE distribution CDs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

During the SUSE Linux 7.3 installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing SUSE
Linux 7.3.

Installation Steps

1

g s W N

Insert the SUSE Linux 7.3 installation CD in the CD-ROM drive.

Power on the virtual machine.

Follow the prompts to complete the installation.

Install using the text mode installer.

When prompted, do not install an X server. In the Configure Monitor screen, choose No X11.
The installer asks you to confirm.

Click Continue and finish the installation.

Install VMware Tools.

VMware Tools in a SUSE Linux 7.3 Guest

After you have installed VMware Tools, you can boot your SUSE 7.3 virtual machine with any of the selections
offered in LILO.

Turbolinux 11
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The easiest method of installing Turbolinux 11 Desktop or Server in a virtual machine is to use the standard
Turbolinux distribution CDs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Turbolinux 11 installation CD in the CD-ROM drive.
Power on the virtual machine.
Follow the prompts to complete the installation.

Install VMware Tools.
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Turbolinux 10

The easiest method of installing Turbolinux 10 Desktop or Server in a virtual machine is to use the standard
Turbolinux distribution CDs.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Turbolinux 10 installation CD in the CD-ROM drive.
2 Power on the virtual machine.

3 Follow the prompts to complete the installation.

4 Install VMware Tools.

Turbolinux 8

The easiest method of installing Turbolinux 8 Workstation or Enterprise Server in a virtual machine is to use
the standard Turbolinux distribution CDs.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the Turbolinux 8 installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing
Turbolinux 8.

Installation Steps

1 Insert the Turbolinux 8 installation CD in the CD-ROM drive.

Power on the virtual machine.

Follow the prompts to complete the installation.

In the first installation screen, press the F2 key, and then press Enter to select the text mode installer.
When prompted, do not install an X server.

In the Desktop Settings screen, choose Text Mode Only and click Accept.
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Install VMware Tools.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2
configuration utility to configure your X server.

Run SaX2 Configuration Utility

To Run SaX2 Configuration Utility

1  Atacommand prompt, type SaX2.

2 Follow the prompts in the wizard to configure your X server.

3 If youintend to connect to this virtual machine with the VMware Virtual Machine Console, configure the
color resolution for 65536 (16-bit) colors or less.
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4 After you run the SaX2 utility, boot the Turbolinux Workstation 8 virtual machine with any of the
selections offered in GRUB.

Turbolinux 7.0

The easiest method of installing Turbolinux 7.0 in a virtual machine is to use the standard Turbolinux 7.0
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

B During the Turbolinux 7.0 installation, a standard VGA16 X server (that does not support the VMware
display adapter) is installed. To get an accelerated SVGA X server running inside the virtual machine,
install the VMware Tools package immediately after installing Turbolinux 7.0, before you start the X
server.

Installation Steps

1  Insert the Turbolinux 7.0 CD No. 1 in the CD-ROM drive.

2 Power on the virtual machine.

3 Follow the prompts to complete the installation.

4  In the Configure Monitor screen, follow the defaults to configure an X server.

This procedure is necessary even though you will install a different X server with VMware Tools after you
finish installing the guest operating system.

Turbolinux 7.0 boots and a login screen appears.

5 Install VMware Tools.

VMware Tools in a Turbolinux 7.0 Guest

Do not start the X server in the guest operating system until you install VMware Tools.

Ubuntu 10.04 and Ubuntu 10.10

The easiest method of installing Ubuntu 10.04 or Ubuntu 10.10 in a virtual machine is to use the standard
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Ubuntu 10.04 or Ubuntu 10.10 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 10.04 or Ubuntu 10.10 installer copies the files it needs to the virtual disk, it ejects the
installation CD and displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.

4  Follow the prompts to complete the installation.
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As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 10.04 or Ubuntu 10.10 user interface, choose System >
Preferences > Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 10.04 and Ubuntu 10.10 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1
2
3

Open a terminal window.
Log in as a normal user.

Type sudo passwd root to set a root password.

Ubuntu 9.10

The easiest method of installing Ubuntu 9.10 in a virtual machine is to use the standard Ubuntu 9.10
distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1
2

5

Insert the Ubuntu 9.10 CD in the CD-ROM drive.
Power on the virtual machine.

After the Ubuntu 9.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

If the virtual machine fails to restart as expected, click the Reset button to restart it.
Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 9.10 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 9.10 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

VMware, Inc.

63



Guest Operating System Installation Guide

Enable Root in a Virtual Machine Running Ubuntu Server Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition
1  Open a terminal window.
2 Login as a normal user.

3 Type sudo passwd root to set a root password.

Ubuntu 9.04
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The easiest method of installing Ubuntu 9.04 in a virtual machine is to use the standard Ubuntu 9.04
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu 9.04 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 9.04 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 9.04 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 9.04 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu 8.10

The easiest method of installing Ubuntu 8.10 in a virtual machine is to use the standard Ubuntu 8.10
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu 8.10 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 8.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 8.10 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 8.10 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition
1  Open a terminal window.
2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu 8.04 LTS

The easiest method of installing Ubuntu 804 LTS in a virtual machine is to use the standard Ubuntu 8.04 LTS
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu 8.04 LTS CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 8.04 LTS installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 8.04 LTS user interface, choose System > Preferences >
Network Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 8.04 LTS Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition
1  Open a terminal window.
2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.
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NOTE For Ubuntu 8.04 LTS, 8.04.1, and 8.04.2, you can install VMware Tools using the tar installer or the
appropriate OSP. For a complete set of instructions for downloading, installing, and upgrading VMware Tools
OSPs, see the VMware Tools Installation Guide Operating System Specific Packages at:
http://www.vmware.com/pdf/osp_install_guide.pdf

Ubuntu Linux 7.10

The easiest method of installing Ubuntu 7.10 in a virtual machine is to use the standard Ubuntu 7.10
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu 7.10 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 7.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 7.10 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 7.10 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.
Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.
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3 Select System > Administration > Users and Groups and click Unlock.
4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.

Ubuntu Linux 7.04

68

The easiest method of installing Ubuntu 7.04 in a virtual machine is to use the standard Ubuntu 7.04
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Ubuntu 7.04 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 7.04 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 7.04 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 7.04 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.
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3 Select System > Administration > Users and Groups and click Unlock.
4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.

Ubuntu Linux 6.10

The easiest method of installing Ubuntu 6.10 in a virtual machine is to use the standard Ubuntu 6.10
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Ubuntu 6.10 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 6.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 6.10 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 6.10 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.

VMware, Inc. 69



Guest Operating System Installation Guide

3 Select System > Administration > Users and Groups and click Unlock.
4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.

Ubuntu Linux 6.06
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The easiest method of installing Ubuntu 6.06 in a virtual machine is to use the standard Ubuntu 6.06
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Ubuntu 6.06 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 6.06 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 6.06 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 6.06 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.
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3 Select System > Administration > Users and Groups and click Unlock.
4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.

Ubuntu Linux 5.10

The easiest method of installing Ubuntu 5.10 in a virtual machine is to use the standard Ubuntu 5.10
distribution CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

B With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Ubuntu 5.10 CD in the CD-ROM drive.
2 Power on the virtual machine.

After the Ubuntu 5.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart.

3 If the virtual machine fails to restart as expected, click the Reset button to restart it.
4  Follow the prompts to complete the installation.

As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist
for 10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes.

5 Install VMware Tools using the tar installer.

When the installation completes, in the Ubuntu 5.10 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 5.10 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

Enable Root in a Virtual Machine Running Ubuntu Server Edition
You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

You need to set a root password to install VMware Tools.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition
1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.
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Select System > Administration > Users and Groups and click Unlock.
In the Authenticate window, type your password and click Authenticate.

Select root, click Properties, and under Set password by hand, establish a root password.

VMware Tools and 64-bit Version of Ubuntu Linux 5.10

The 64-bit version of Ubuntu Linux 5.10 lacks the driver needed for correct operation of the X server in the
virtual machine. The driver is installed when you install VMware Tools. To install VMware Tools in the 64-bit
version of Ubuntu Linux 5.10, see knowledge base article at http://kb.vmware.com/kb/1900.

Ubuntu Linux 5.04

The easiest method of installing Ubuntu 5.04 in a virtual machine is to use the standard Ubuntu 5.04
distribution CD.
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Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many Linux guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

5

Insert the Ubuntu Linux CD in the CD-ROM drive.
Power on the virtual machine.

If your host computer is on a network that uses a proxy server for Internet access, enter information about
the proxy server name and port at the boot prompt.

linux http_proxy=http://<proxy_servers>:<port_number>
Follow the prompts to complete the installation.

You can now become root at any time using the normal su — command and the root password you just
created.

Install VMware Tools.

When the installation completes, in the Ubuntu 5.04 user interface, choose System > Preferences > Network
Proxy to set the HTTP proxy in the Network Proxy Preferences dialog box.

VMware Tools in an Ubuntu 5.04 Guest

To install VMware Tools using the tar installer, enable root in the Ubuntu guest.

To Enable Root in a Virtual Machine Running Ubuntu Server Edition

1
2
3

Open a terminal window.
Log in as a normal user.

Type sudo passwd root to set a root password.

To Enable Root in a Virtual Machine Running Ubuntu Desktop Edition

1
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Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.

Select root, click Properties, and under Set password by hand, establish a root password.
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FreeBSD 8
Install FreeBSD 8 from a DVD or CDs.
Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.
B Download the ISO images from the FreeBSD Web site.

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 8:

1  Insert the FreeBSD 8 CD or DVD into the CD-ROM drive.
Power on the virtual machine.

Follow the prompts to complete the installation.
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Install VMware Tools.

Known Limitation for FreeBSD 8

Occasionally, screen distortion occurs with using GNOME with FreeBSD 8.0. See knowledge base article
1021745 at http://kb.vmware.com/kb/1021745.

Due to a third-party issue, you will experience installation problems if you install FreeBSD 8 64-bit configured
with 32 vCPUs. To work around this issue, change the vCPU value to 31. For more information see,
http://www.freebsd.org/cgi/query-pr.cgi?pr=148698&cat.

The FreeBSD 8.2 release includes a fix for the installation problem.

FreeBSD 7.x
Install FreeBSD 7.x from a DVD or CDs.
Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.
B Download the ISO images from the FreeBSD Web site:

®  With many FreeBSD guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 7.x:

1  Insert the FreeBSD 7.x CD or DVD into the CD-ROM drive.
2 Power on the virtual machine.

3 Follow the prompts to complete the installation.

4  Install VMware Tools.

For additional installation instructions, see http://www.freebsd.org/doc/en/books/handbook/install.html.

VMware Tools in a FreeBSD 7.x Guest

Do not start the X server in the guest operating system until you install VMware Tools.
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FreeBSD 6.x

You can install FreeBSD 6.x from a DVD or CDs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.
Download the ISO images from the FreeBSD Web site:

With many FreeBSD guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3
4

Insert the FreeBSD CD in the CD-ROM drive.
Power on the virtual machine.
Follow the prompts to complete the installation.

Install VMware Tools.

For additional installation instructions, see http://www.freebsd.org/doc/en/books/handbook/install.html.

FreeBSD 5.x

The easiest method of installing FreeBSD 5.x in a virtual machine is to use the standard FreeBSD
distribution CD.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

With many FreeBSD guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3
4

Insert the FreeBSD 5.x CD in the CD-ROM drive.
Power on the virtual machine.
Follow the prompts to complete the installation.

Install VMware Tools.

For additional installation instructions, see http://www.freebsd.org/doc/en/books/handbook/install. html.

FreeBSD 4.x

The easiest method of installing FreeBSD 4.x in a virtual machine is to use the standard FreeBSD
distribution CD.

Before you begin, verify that the following tasks are complete:
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Read “General Installation Instructions for All VMware Products” on page 13.

With many FreeBSD guest operating systems, problems were observed when the BusLogic virtual SCSI
adapter was used with VMware virtual machines. VMware recommends that you use the LSI Logic
virtual SCSI adapter with this guest operating system.

VMware recommends that you configure ESX Server virtual machines that use this guest operating
system to use the vmx Ethernet adapter. See your product documentation for instructions.

FreeBSD 4.6 is not supported. Use FreeBSD 4.6.2 instead. It resolves an issue that interferes with
installation of FreeBSD 4.6 in a virtual machine.
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Installation Steps

1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.
3 Follow the prompts to complete the installation.

4  Install VMware Tools.

For additional installation instructions, see http://www.freebsd.org/doc/en/books/handbook/install.html.

Installation Instructions for FreeBSD 4.11, 4.10, and 4.9

After powering on the virtual machine complete this step:

In the FreeBSD Disklabel Editor step, do not use the installer's default option A partitioning. Use option C to
create the mounts. In order to install VMware Tools, you need more space in /usr than is provided by the
installer defaults. Include at least 4,000,000 blocks for /usr in the partitioning scheme.

Installation Instructions for FreeBSD 4.3, 4.2, 4.1, and 4.0

When you install FreeBSD 4.3, 4.2, 4.1, and 4.0, consider these support and configuration issues.

®  [fyou create your virtual machine with a virtual IDE disk, installation proceeds as it would on a physical
machine. If you create your virtual machine with a SCSI virtual disk that is 2GB or larger you need to set
the disk geometry.

®m  If you install FreeBSD 4.3, 4.2, 4.1, and 4.0 as the guest operating system on a 2GB or larger SCSI virtual
disk, the guest operating system does not boot unless you take special steps.

B The guest fails to boot because the virtual disk geometry is not probed correctly by FreeBSD when you
install the guest operating system. FreeBSD installs the boot loader in the wrong location on the virtual
disk. When FreeBSD tries to boot, the FreeBSD boot loader asks the BIOS for important data that is now
on a different section of the virtual disk, so FreeBSD cannot boot.

This problem has been fixed in FreeBSD 4.4. This and later versions correctly boot SCSI virtual disks of
any size.

B Select one of the following methods to use FreeBSD 4.3, 4.2, 4.1, and 4.0 in a virtual machine.

®  Use an IDE virtual disk in your virtual machine. You might need to add the IDE virtual disk to the
virtual machine with the Configuration Editor.

B Manually set the disk geometry when installing FreeBSD.

Set the Disk Geometry Manually

FreeBSD calculates an incorrect disk geometry before you arrive at the FDISK Partition Editor. Therefore, you
must set the disk geometry manually.

To Set the Disk Geometry Manually
1 To set the disk geometry, press G to select the option Set Drive Geometry.

A dialog box appears, containing numbers like 2055/64/32. These numbers represent the number of
cylinders, heads, and sectors per head. These numbers are the incorrect geometry.

2 Calculate the correct geometry.

a  Find the total number of sectors by multiplying the number of cylinders, heads and sectors per head
together.

b Divide the number of sectors by the correct number of heads and sectors per head.

3 Enter the correct geometry separated by slashes (/).
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4
5

Click OK.

Follow the prompts to complete the installation.

NetWare 6.5 Server

You can install NetWare 6.5 in a virtual machine using the standard Novell NetWare 6.5 Operating System and
Product CD-ROMs.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

When you create a virtual machine for NetWare 6.5 with Novell Open Enterprise Server on an ESX Server,
select Novell NetWare for the guest operating system and Novell NetWare 6.x for the version.

VMware recommends you install NetWare 6.5 on a computer with at least 512MB of memory.

Guests without Support Pack 1. Read the Novell technical information document at
support.novell.com/cgi-bin/search/searchtid.cgi?/2967370.htm. This document describes the steps
necessary to download and install a NetWare patch required when you install a NetWare 6.5 Server guest
operating system without SP1.

When you configure a virtual machine for a NetWare 6.5 guest, use the virtual LSI Logic SCSI adapter.
NetWare 6.5 does not include a driver for the virtual BusLogic SCSI adapter.

Installation Steps

1
2
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Insert the Novell NetWare 6.5 Product CD in the CD-ROM drive.
Power on the virtual machine.

A few prompts appear before you reach the license agreement.
Read and accept the license agreement.

Accept the defaults for installing NetWare, the CD-ROM drive type, how to restore the floppy drive and
the run mode, and then continue.

When prompted, choose IDE CD-ROM.

Create a new boot partition.

The guest operating system reboots. The installation continues.
VMware ESX Server: Jump to Step 8.

VMware Workstation, VMware ACE, and VMware GSX Serve. To configure IP networking, do one of
the following.

®  For bridged networking for the virtual machine, enter its IP address.

When NetWare tries to load the LAN driver (using pcntnw. Lan), it fails because it broadcasts for its
own IP address. This behavior causes IP networking to fail.

To work around this, open the System Console (press Ctrl+Esc) and type the following command:
set allow ip address duplicates=on

Press Alt+Esc to return to the installation.
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For host-only networking for the virtual machine, look up the host machine’s IP address.
At a command prompt on a Windows host, type:

ipconfig /all

At a command prompt on a Linux host, type:

ifconfig

Note the host’s IP address for VMnet1 and change the last octet so that it is greater than the last octet
in the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.4##,
where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the host’s IP address (192.168.160.1 in the example).

For network address translation (NAT) for the virtual machine, look up the host machine’s IP
address.

At a command prompt on a Windows host, type
ipconfig /all

At a command prompt on a Linux host, type
ifconfig

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.4##,
where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the NAT service’s IP address (192.168.160.2 in our example).
Note that with Network Address Translation, there are 2 IP addresses in use on the host:

B The IP address assigned to the interface for VMnet8 (which shows up in the ipconfig output
with a .1 in the last octet).

B The IP address used by the NAT device itself (which always uses .2 as the last octet).

Follow the prompts to complete the installation.

Install VMware Tools, which installs and loads the CPU idler program.

VMware Tools in a NetWare 6.6 Server Guest

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.

NetWare 6.0 Server

You can install NetWare 6.0 in a virtual machine using the standard Novell NetWare 6.0 CD-ROM.

Before you begin, verify that the following tasks are complete:

VMware, Inc.

Read “General Installation Instructions for All VMware Products” on page 13.

VMware recommends you install NetWare 6.0 on a computer with at least 256MB of memory.
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In the NetWare installation process, you must boot from the installation CD twice—once to format the
virtual machine's disk drive, and a second time to install files from the CD.

On the reboot, you see the message Operating System not found and a dialog box with the message
No bootable CD, floppy or hard disk was detected.

To boot from the CD the second time, change the boot order.

As the virtual machine boots, click inside the virtual machine window. When the VMware logo appears,
press Esc. Use the arrow keys to select the CD drive as the boot device, and then press Enter.

When you configure a virtual machine for a NetWare 6.0 guest, use the virtual LSI Logic SCSI adapter.
NetWare 6.0 does not include a driver for the virtual BusLogic SCSI adapter.

Installation Steps

1
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Insert the NetWare 6.0 Server CD in the CD-ROM drive.

Power on the virtual machine.

Read and accept the license agreement.

When prompted, choose IDE CD-ROM.

Create a new boot partition.

The guest operating system reboots.

Configure IP networking.

®  For bridged networking for the virtual machine, enter its IP address.

When NetWare tries to load the LAN driver (using pcntnw. Lan), it fails because it broadcasts for its
own IP address. This causes IP networking to fail.

To work around this, open the System Console (press Ctrl+Esc) and type
set allow ip address duplicates=on
Press Alt+Esc to return to the installation.
®  For host-only networking for the virtual machine, look up the host machine's IP address.
At a command prompt on a Windows host, type:
ipconfig /all
At a command prompt on a Linux host, type:
ifconfig

Note the host’s IP address for VMnet1 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###,
where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.

For the router gateway, enter the host’s IP address (192.168.160.1 in this example).
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®  If you chose network address translation (NAT) for the virtual machine, look up the host machine's
IP address.

At a command prompt on a Windows host, type:
ipconfig /all

At a command prompt on a Linux host, type:
ifconfig

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###,
where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the NAT service’s IP address (192.168.160.2 in this example).
With Network Address Translation, the host uses two IP addresses:

®  TheIP address assigned to the interface for VMnet8 appears in the ipconfig output witha1in
the last octet.

®  The IP address used by the NAT device itself always uses 2 as the last octet.
Follow the prompts to complete the installation.

Install VMware Tools, which installs and loads the CPU idler program.

VMware Tools in a NetWare 6.0 Server Guest

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.

NetWare 5.1 Server

You can install NetWare 5.1 Server in a virtual machine using the standard Novell NetWare 5.1 Server
CD-ROM.

Before you begin, verify that the following tasks are complete:
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Read “General Installation Instructions for All VMware Products” on page 13.
VMware recommends you install NetWare 5.1 on a computer with at least 256MB of memory.

If you are running NetWare 5.1 Server Support Pack 6, install the latest LSI Logic SCSI driver. For
information on obtaining and installing the driver, see http://kb.vmware.com/kb/1181.

For SCSI support, download the latest LSI Logic driver.

In the NetWare installation process, boot from the installation CD twice—once to format the virtual
machine's disk drive, and a second time to install files from the CD.

On the reboot, you see the message Operating System not found and a dialog box with the message
No bootable CD, floppy or hard disk was detected.

To boot from the CD the second time, change the boot order.

As the virtual machine boots, click inside the virtual machine window. When the VMware logo appears,
press Esc. Use the arrow keys to select the CD drive as the boot device, and then press Enter.
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Installation Steps

1
2
3

Insert the NetWare 5.1 Server CD into the CD-ROM drive.

Power on the virtual machine.

Read and accept the license agreement.

Create a new boot partition.

The guest operating system reboots. The installation continues.

VMware ESX Server. Skip to Step 6.

VMware Workstation, VMware ACE and VMware GSX Server. To configure IP networking, do one of
the following:

For bridged networking for the virtual machine, enter its IP address.

When NetWare tries to load the LAN driver (using pcntnw. lan), it fails because it broadcasts for its
own IP address. This causes IP networking to fail.

To work around this, open the System Console (press Ctrl+Esc) and type

set allow ip address duplicates=on

Press Alt+Esc to return to the installation.

For host-only networking for the virtual machine, look up the host machine's IP address.
At a command prompt on a Windows host, type:

ipconfig /all

At a command prompt on a Linux host, type:

ifconfig

Note the host’s IP address for VMnet1 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, and then the virtual machine’s IP address is
192.168.160.###, where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the host’s IP address (192.168.160.1 in this example).

For network address translation (NAT) for the virtual machine, look up the host machine's IP
address.

At a command prompt on a Windows host, type:
ipconfig /all

At a command prompt on a Linux host, type:
ifconfig

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###,
where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.

For the router gateway, enter the NAT service’s IP address (192.168.160.2 in this example).
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Note that with Network Address Translation, there are two IP addresses in use on the host:

B The IP address assigned to the interface for VMnet8 shows up in the ipconfig output with a1
in the last octet.

®  The IP address used by the NAT device itself always uses 2 as the last octet.
6  Follow the prompts to complete the installation.

7 Install VMware Tools, which installs and loads the CPU idler program.

VMware Tools in a NetWare 5.1 Server Guest

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.

NetWare 4.2 Server

You can install NetWare 4.2 Server in a virtual machine using the standard Novell NetWare 4.2 Server
installation CD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.
®m  If you created this virtual machine on a Linux host follow these steps:
a  Open the configuration file (<netware>. cfg) in a text editor and add the following line:
gui.iconLEDS = false

b This removes all the LED icons in the console window, which prevents the virtual machine display
from appearing incorrectly when you power it on while the host is in 8 bit/256 color mode.

¢ Install the guest operating system and VMware Tools, which includes the CPU idler program. See
“VMware Tools in a NetWare 4.2 Server Guest” on page 83

B VMware recommends that you install NetWare 4.2 Server on a host with at least 256MB of memory.

Installation Steps

1 VMware recommends that you install MS-DOS 5.0 or higher in a small (50MB FAT16) partition as
described in these guidelines. The rest of the free space on the virtual disk is used for the NetWare
partition. Even if the virtual machine is to run NetWare most of the time, it is a good idea to install a CPU
idler program.

2 Install a CD-ROM driver or CD-ROM software for MS-DOS.

If you have problems setting up the MS-DOS virtual machine to access the CD-ROM drive, you can use
the mtmcdai . sys driver, which can be found at www.mitsumi.com. Under Drivers and Manuals look for
idel58.exe.
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3 Modify the config.sys and autoexec.bat files on your MS-DOS boot floppy (along with the
mscdex. exe file) as shown below. If you are using a MS-DOS boot partition, adjust the drive letters

accordingly.

config.sys

device=himem.sys /testmem:off
device=NEC_IDE.SYS /D:MSCD00O1

files=12
buffers=15
stacks=9,256
lastdrive=z

autoexec.bat
@ECHO OFF

set EXPAND=YES
SET DIRCMD=/0:N
cls

set temp=c:\
set tmp=c:\
path=c:\

IF "%config%"=="NOCD" GOTO QUIT
a:\NWCDEX.EXE /D:mscd001

:QUIT

After you have configured the CD-ROM software, verify that the virtual machine can read a CD from the

host system’s CD-ROM drive.

4 If the virtual machine is not running, power it on and wait for MS-DOS to finish its boot process.

5 Insert the NetWare 4.2 CD in the CD-ROM drive on the GSX Server host.

6  Inthe virtual machine, at the MS-DOS prompt, run the fdisk command to create a partition for NetWare.

A:\>fdisk

7 After you create the partition, press Ctrl+Alt+Insert to reboot the virtual machine.

8  Format the C: drive. Type the following:

format c: /s /x

9  Type the following command to copy the following files to your C: drive from your floppy.

Copy autoexec.bat c:

Copy config.sys c:
Copy himem.sys c:
Copy nwcdex.exe c:

Copy nec_ide.sys c:

10 Modify the autoexec.bat file so it points to the CD-ROM directory on the hard drive instead of the

floppy drive.

a Tomodify autoexec.bat, type the following at the C: prompt:
a:edit autoexec.bat

b In the line that reads a:\NWCDEX.EXE /D:mscd001, change the drive from A to C.

¢ Save the changes you just made.

cd d:

11 Run the INSTALL.BAT program to start the NetWare server installation process.

If the virtual machine has been configured for networking (bridged, host-only, NAT or custom), the
installation program detects a PCI Ethernet adapter and prompts you with a list of possible drivers.

82

VMware, Inc.



Installing Guest Operating Systems

12 At this point, do not select or load any LAN drivers; press the F3 key to continue installing withouta LAN
driver.

NOTE After the installation is completed, you can load and bind the appropriate LAN driver. Selecting
or loading a LAN driver during the NetWare 4.2 installation might cause the installation process to stall.

13 Follow the prompts to complete the installation.
14 Shut down the server and type exit to return to a MS-DOS prompt.

15 Install VMware Tools, which installs and loads the CPU idler program.

VMware Tools in a NetWare 4.2 Server Guest

In NetWare 4.2 virtual machines, VMware Tools provides CPU idling, sends a heartbeat from the guest
operating system to the host and gives the virtual machine the ability to be gracefully powered on or off.
Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.

Solaris 10 Operating System x86 Platform Edition

VMware products support only the version for x86 platforms. You cannot install the version for SPARC
platforms in a VMware virtual machine.

The easiest method of installing the Solaris 10 Operating System in a virtual machine is to use the standard
Solaris 10 for x86 installation media. The notes below describe an installation using the CD set or DVD.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.
B VMware Server or ESX Server

®m  For the Solaris 10 9/10 release, Sun recommends 1GB of memory. 768MB is the minimum
requirement.

®m  For the Solaris 10 1/06 release, Sun recommends 512MB of memory. 256MB is the minimum
requirement.

®m  For the Solaris 10 3/05 release, Sun recommends 256MB of memory. 128MB is the minimum
requirement.

B Before upgrading a virtual machine’s guest operating system to the latest Solaris 10 release, increase the
virtual machine’s RAM. See your VMware product documentation for instructions. For more information
see the System Requirements and Recommendations for Solaris 10 Installation, on the Sun Web site at:
http://docs.sun.com/app/docs/doc/817-0544/6mgbagbOv?a=view

Installation Steps

1  Insert the Solaris 10 Operating System for x86 Platforms DVD or the Solaris 10 Software 1 CD in the DVD
or CD-ROM drive.

2 Power on the virtual machine.
3 Follow the prompts to complete the installation.

4  Install VMware Tools.

VMware Tools in a Solaris 10 Guest
On ESX, VMware Tools is supported on ESX 3.x and later.
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Solaris 9 Operating System x86 Platform Edition

VMware products support only the x86 Platform Edition. You cannot install the SPARC Platform Edition in a
VMware virtual machine.

Before you begin, verify that the following tasks are complete:
B Read “General Installation Instructions for All VMware Products” on page 13.

®  [f you want to use a SCSI hard disk in your virtual machine, configure the virtual machine to use the LSI
Logic adapter and use Solaris 9 9/04 or a later release. An LSI Logic driver is included in releases
beginning with Solaris 9 9/04. If you use an earlier release of Solaris 9 and configure the virtual machine
to use a SCSI hard disk, you must get the LSI Logic driver and install it as an install time update. To locate
the driver, go to the LSI Logic download page at www.lsi.com/support/download_center/ and select
LSI53C1030 from the Select a Specific Product drop-down list.

®m  Skip configuring the KDM X server at the first two opportunities. Wait for the third opportunity.

Installation Steps

1  Insert the Solaris 9 x86 Platform Edition installation CD in the CD-ROM drive.

Power on the virtual machine.

When the Boot Solaris screen appears, Press F4.

In the Boot Tasks screen, use the arrow keys to select View/Edit Property Settings and press Enter.
Press F2 to continue.

Use the arrow keys to select ata-dma-enabled and press Enter.

Press F3 to change the value.

Type 1 and press Enter to enable DMA at the Specify Value prompt.
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Press F2 in the View/Edit Property Settings screen.
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Press F3 in the Boot Tasks screen.

—_
—_

Select CD in the Boot Solaris screen if you are installing from the CD-ROM set and continue with the
installation.

Configure the X Server

Do not configure the KDM X server until all the software is installed and before you configure the X server.

To Configure the X Server
Do not configure the KDM X server until all the software is installed and before you configure the X server.

1 When the kdmconfig - Introduction screen appears during installation, press F4 to skip configuring the
X server and continue with the installation.

After the software installation completes, the installer prompts you for the root password to configure the
X Server (Windows System Configuration).

Enter the root password. The kdmconfig Mismatch Detected screen appears.
Press F2 to configure.
Select Change Video Device/Monitor and press F2 to continue.

Press Enter to select 16-color Standard VGA 640x480 (256K) and press F2 to continue.
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Use the arrow keys to select Multifrequency 100KHz (up to 1600x1200 @ 80Hz)
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Press Enter and press F2 to continue.

Do not change the default screen size of 17 inches.

Press F2 to continue.

Do not change the default screen resolution of 640x480.

Press F2 in the Virtual Screen Resolution Selection screen.

Do not change the default No changes needed — Test/Save and Exit.
Press F2 to continue.

Press F4 to bypass the Windows System Configuration tests.

Follow the prompts to complete the installation.

VMware Tools in a Solaris 9 Guest

VMware Tools does not support Solaris 9.

Solaris 8 Operating System x86 Platform Edition

VMware products support only the x86 Platform Edition. You cannot install the SPARC Platform Edition in a
VMware virtual machine.

Before you begin, verify that the following tasks are complete:

Read “General Installation Instructions for All VMware Products” on page 13.

The Solaris 8 installation CD does not include the Solaris 8 SCSI (LSI/LSISAS) drivers. If you select
LSI/LSISAS drivers when installing the guest on the virtual machine, it will not detect the SCSI hard disk
unless you install the drivers during the Solaris 8 installation. As a result, you need to create an Install
Time Update (ITU) driver disk.

If you plan to use a SCSI hard drive, see “Adding a SCSI Driver” on page 86.

If you selected an IDE controller, begin installing Solaris 8 by following the “Installation Steps” on
page 85.

Skip configuring the KDM X server at the first two opportunities. Wait for the third opportunity.

Installation Steps

In most respects, follow the prompts to complete the installation.

1
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Insert the Solaris 8 x86 Platform Edition installation CD in the CD-ROM drive.

Power on the virtual machine.

When the Boot Solaris screen appears, Press F4.

In the Boot Tasks screen, use the arrow keys to select View/Edit Property Settings and press Enter.
Press F2 to continue.

Use the arrow keys to select ata-dma—enabled and press Enter.

Press F3 to change the value.

Type 1 and press Enter to enable DMA at the Specify Value prompt.

Press F2 in the View/Edit Property Settings screen.

Press F3 in the Boot Tasks screen.

Select CD in the Boot Solaris screen if you are installing from the CD-ROM set and continue with the
installation.
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Configure the X Server

Do not configure the KDM X server until all the software is installed and before you configure the X server.

To Configure the X Server

1 When the kdmconfig - Introduction screen appears during installation, press F4 to skip configuring the X
server and continue with the installation.

After the software installation is complete, the installer prompts you for the root password to configure
the X Server (Windows System Configuration).

Enter the root password. The kdmconfig Mismatch Detected screen appears.

Press F2 to configure.

Select the default Change Video Device/Monitor and press F2 to continue.

Press Enter to select 16-color Standard VGA 640x480 (256K) and press F2 to continue.

Use the arrow keys to select Multifrequency 100KHz (up to 1600x1200 @ 80Hz) and press Enter.
Press F2 to continue.

Do not change the default screen size of 17 inches.
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Press F2 to continue.
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Do not change the default screen resolution of 640x480.

—_
—_

Press F2 in the Virtual Screen Resolution Selection screen.
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Do not change the default No changes needed - Test/Save and Exit.

—_
N}

Press F2 to continue.

—
S

Press F4 to bypass the Windows System Configuration tests.

15 Follow the prompts to complete the installation.

Adding a SCSI Driver

To add a SCSI drive, first create a driver disk with the Solaris 8 drivers. During installation when you install
the drivers, the drivers detect the SCSI hard drive.

Download SCSI drivers for Solaris 8 from the LSI Web site:

http://www.1si.com/DistributionSystem/AssetDocument/itmpt_x86_5.07.04.zip

Creating an ITU Driver Disk Using Solaris
Use the existing dd image itmpt-x86-50704-itu—-s9.dd file in the zip file to create the driver disk.
Type the following command to create the driver disk:

dd if=itmpt-x86-50704-itu-s9.dd of=/vol/dev/aliases/floppy® bs=32768

NOTE If you want to use Windows to create the disk, refer to the instructions in itmpt_x86_5.07.04. txtin
the zip file.
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Detect the SCSI Hard Drive
These instructions apply to both SCSI and LSI/LSI SAS.

To Detect the SCSI Hard Drive

1  When you begin the installation, press F4 in the Solaris Device Configuration Assistant screen to add the
drivers.

2 Insert the ITU disk (connect the Floppy drive to A: in the virtual machine).
3 Press F2 to continue.
The disk loads the software on the virtual machine.
4 In the Continue Supplement Driver Installation screen, disconnect the disk and press F4.
5  Press F2 to continue the installation in the Identified Device Drivers screen.

6  Follow the rest of the installation steps from Step 3 in “Installation Steps” on page 85.

VMware Tools in a Solaris 8 Guest

VMware Tools does not support Solaris 8.
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